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Once on The Computer Workshops website, look at
the bottom 
of any page to find the link Download. Clicking this
link opens the Download page where you can choose
either Data Files or 
Handouts. 

1. Data Files opens a list of general application types. 
2. Click once on the Microsoft Office Courses link.
3. Click once on the software related to the course.
4. Click once on the version related to the course.
5. If there are multiple folders, click on the TCW folder.
6. Click on the course name to download the datafiles.

You can choose to open or save the zipped folders

content to 
your computer. 
The handouts are in PDF format and also available to

you 
without login or password. Simply open the PDF andeither 
print or save to your computer.

Welcome to the Excel Formulas course. This manual and the data
files are designed to be used for learning, review and reference
after the class. The data files can be downloaded any time from 
website: 

There is no login or password required to access these files. You
will also find handouts and supplementary materials on the
website in the Download section.

The Computer Workshop
http://www.tcworkshop.com

To Download Data Files

Using this
Manual
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Conventions Used in this Manual

 Information that you need to supply will be indicated
with pointed brackets. Example: Type: <your name>.

The hands-on exercises (Actions) are written in a two-column
format. The left column (“Instructions”) gives numbered

instructions, such as what to type, keys to press, commands 
to choose from menus, etc. The right column (“Results/

Comments”), contains comments describing results of, reasons
for, quick keys, etc. for the instructions listed on the left.

  Key names and Functions are bold and enclosed in 
square brackets:
 [Enter], [Tab], [F5], [F10]

  Keys you press simultaneously are separated by a plus 
(+) sign, typed in bold and enclosed in square brackets. 

You do not press the plus.

 [Shift + F5]

  Keys you press in sequence are separated by a space, 
bold and enclosed in square brackets.

 [Home] [Down Arrow]
  Ribbon tab names are in bold and italic: Example: 
Home 

  Group names are in bold: Example: Font

  Dialog box names are in italic: Example: Save As

  Button names are bold and enclosed in square brackets: 
Example: [Sort]
  Information you are to type will be in bold. Example:

 

This is the first day of the rest of your life.

Conventions



Lesson Overview

 Logical Functions

 Names

 IF Functions

 Nested IF

Functions  IFS

Functions

 AND Functions

 OR Functions

 NOT Functions

Excel:
Formulas 6.0,
02/17/2020

You will cover the following concepts
in this chapter:

  Lookup Functions

  VLOOKUP Functions

  HLOOKUP Function

  Data Validation List

  MATCH Function

  INDEX Function

Lesson 1: Logical &
Lookup Functions

  

  

  

  

  

  

  

 



Lesson Notes
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Lesson 1: Logical & Lookup Functions

A logical function is one that evaluates an expression or value 
and returns a value based upon whether the expression is True 
or False. These are formulas that are commonly used to see if a
condition is met or not to determine one action or another. 

You use a logical function to check a condition. For example, you 
wanted to determine if your actual expenses are over budget or 
determine if a client is eligible for a discount.

Testing whether conditions are true or false and making logical 
comparisons between expressions are common to many tasks. 
You can use the AND, OR, NOT, and IF functions to create 
conditional formulas.
In the [Logical] formulas drop-down button in the Function 
Library Group on the Formulas Tab you will notice TRUE and 
FALSE functions. These formulas don’t require any arguments 
and will simply return the same value as the function. In essence 
you just as easily write True or False into the cell and be done 
with it.
  =TRUE() returns True

  =FALSE() returns False



Also within this group of functions you will find the IF, AND, 
OR, and NOT formulas. These can be used as stand alone 
functions and also in conjunction with an IF to expand the 
capabilities of the IF to much broader parameters. 

Logical

Functions

If you are 
searching for text 
or mathematical 
expressions, remember
to wrap the search

values in quotations.
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Names Naming Cells

Editing Names
   button in the 

.

 Select the cell or cells you want to name.

 Click into the Name Box and type in the name.

Instead of referring to cell addresses in formulas it is easier to
refer to the cell’s name. This concept was introduced in the
2016 Level 2 book in Lesson 5. Therefore, this will be a short
review of using Names in formulas. 

 In the Name Manager dialog box, select the name that 
needs to be edited and click the [Edit] button.

  Remember not to use special characters in the 
name.

 Do not use blank spaces.

 Use underscores or camel-case multi-word names.

 Press the [Enter] key or the name will not be applied.

 Click the [Name Manager]
Names Group on the Formulas Tab

Defined 

Excel 

Naming cells
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Lesson 1: Logical & Lookup Functions

Names,
continued

In the dialog box.

  Name: field you can fix typos or rename the cell or 
range.

  Scope: filed is grayed out because that was defined 
when the name was created. When assigning 
names with the Name Box the scope is by default 
global.

  Comment: field you can explain the name.

  Refers to: field you can redefine the cell or cells 
addresses.

If it is only the Refers to: field that needs to be edited, then this 
can be done in the Name Manager dialog box. 
  Select the name to be edited.

  Click into the Refers To: field at the bottom of the 
dialog box.

  Click the [Expand/Collapse] dialog button and 
highlight the correct range of cells.
  Click the [Expand/Collapse] to redisplay the Name 
Manager dialog box.

  Click the [Check] button to apply the edit. If you forget 
this last step the edit will not be applied.

  Click the [Close] button to exit the Name Manager 
dialog box.

  Edit Name 
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Instructions: 
Loan.xlsx

MyLoan.

Action 1 – Naming Cells

Results/ Comments:
1. Open . 2. Save

the file as 

3. Select cell B6.

4. Click into the Name Box and type: State 
then, press the [Enter] key.



5. Repeat steps 3 and 4 for the following 
names.



 Range Range Name
 A13:C22 Table
 B25 MiTax
 B26 OhTax
 I5 Rate
 I7 Years



6. Click the drop-down arrow on the Name


Box to see that all the names are listed.



7. Save the file.

If one or more of the names are not listed
go back to the cell and apply the name.



[Ctrl + S].

The file is located in the Data Files folder 

[F12].

Formulas can become quite complex. To
aid you in writing the formulas, create the
following range names. 

This is the first cell to assign a name to.

The Name Box will now display the name
State instead of the address B6.



Cells that will be referred to in formulas are
now named.
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Lesson 1: Logical & Lookup Functions

IF Functions

Logical Test Value if False

If the salesperson’s sales total is above 5000 then the sales total

will be multiplied by 5% to determine the amount of the bonus.

Should the sales total be less than 5000 then a zero value is

returned. 

One of the most common logical functions is the IF function

which performs a comparison, or test, and then displays the

result in the active cell based on the outcome of that test. The IF

function will return one value if a condition you specify is TRUE

and another value if it is FALSE.

There are three arguments required in the function:

  isany value or expression that can be 
evaluated as true or false

  is the value returned if the expression is 
true.

  is the value returned if the expression is 
false.
For example, you need to determine if a salesperson has sold 
above a set goal in order to earn a bonus. The goal level is a value 
of $5000. If they sold more than that amount they will receive a 
bonus of 5% of their total sales; if not they will not receive their 
bonus. The sales total is in cell F5 and the bonus calculation is in 
cell G5. The formula in cell G5 would be as follows:
FunctionValue if True

IF

IF(logical_test,value_if_true,value_if_false)

logical_test: 

value_if_true:

value_if_false: 

IF Functions

=If(F5>5000,F5*5%,0)
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Instructions:

MyLoan

Mi.

Oh.

B6 (State

Action 2 – IF Function

B6 (State

=IF(State=”oh”,OhTax,MiTax)

Results/ Comments:

5. Type in 

7. Type in 

8. Save the file.

6. Reselect cell 

4. Click into cell 

3. Enter this formula. 

).

).

1. should still be open. If not, open 
it.



2. Select cell I9. This cell will show that appropriate sales

tax based on which state is entered in cell
B6 (State).

The first argument of this formula will
determine if cell B6 (State) contains the
value Oh. Since Oh is text it must be
wrapped in quotation marks. Should 
cell B6 (State) contain Oh, the formula
displays the second argument, OhTax; if
not, then the third argument is returned,
MiTax.

This is the cell that is being checked by the
IF function in cell I9.



The value in cell I9 now shows the value
from the cell named OhTax. The IF 
function Logical_test argument is not case
sensitive.



You will change the state to change the
sales tax to reflect this change.

The value in cell I9 now shows the value
from the cell named MiTax.

[Ctrl + S].
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Lesson 1: Logical & Lookup Functions

Nested IF
Functions

Nested IF Statements

Nested IF Function

In this example the sales total is in cell F5. If the salesperson’s 
sales total is greater than 5000 then the sales total will be 
multiplied by 5% to determine the bonus. If not, next IF is run to 
see if the sales total is greater than 2000. If this is True, then the 
sales total will be multiplied by 3%. If neither of these Logical 
Tests prove True, the formula will return a value of 0.

At times you will want to check for multiple conditions. This can

be done in a single formula by nesting multiple IF’s inside the

formula. The subsequent IF’s are placed in the Value if False part

of the formula. Should the Logical Test return a True value then

the formula stops calculating since an answer has been found. If
the Logical Test returns a False value then the next IF function is

run, this continues until either a True response is found or there

are no other Logical Tests to run and the False is returned. 

Example of a Nested IF statement:
Primary IF Function

A Primary IF can 
have up to seven 

IFs nested in a 
single formula.

=IF(F5>5000,F5*5%,IF(F5>2000,F5*3%,0))
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Instructions:
1. MyLoan

I9.

6% 

B27

Indiana

B27.

=IF(State=”oh”,OhTax,
IF(State=”mi”,MiTax,

IF(State=”in”,InTax,

“out of region”)))

[Enter]

Action 3 – Nesting IF Functions

[Tab] 

InTax.

Results/ Comments:

3. Type in 

4. Select cell 

5. Type in 

6. Select cell 

7. Select cell 

8. Enter this formula. 

11. Save and close the file.

9. Select cell B6 (State).

10. Type in In and press the 

and press the 

 key.

and press the [Enter] key.


 and apply the name 

key.

 should still be open. If not, open 
it.



2. Select cell A27. We are going to add another state to the

region of states we work in.
 
This is the additional state.

This cell will contain the sales tax rate for
the state.

Instead of using the cell address in the

formula we want to continue using names.

The IF function needs to be edited to

include the additional state.

If B6 (State) contains the value oh the

formula returns the OhTax value. If not,

then the False argument begins a new IF

function, to a maximum of seven nested

IFs. The final False in this case returns a

text value of out of region. In the formula

any text values must be wrapped in

quotations marks.

To test the formula.

The value in cell I9 now shows the value

from the cell named InTax.

[Ctrl + S] and [Ctrl + W].
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Lesson 1: Logical & Lookup Functions

IFS Functions IFS Functions

Logical TestLogical TestLogical Test

 Each subsequent Logical Test and Value if True adds 
anther conditional check and return option.

While using nested IF functions is very useful, the limit of seven

nested functions may not offer enough options to fulfill your

needs. In the latest version of Excel 2019/ 365 a new function

called IFS has been added, this function allows up to 127 
different conditions in a single formula. 

There are two basic arguments required in the IFS function:

  logical_test: is any value or expression that can be 
evaluated as true or false

  value_if_true: is the value returned if the expression is 
true.
The syntax of the formula is as follows:

FunctionValue if TrueValue if TrueValue if True

=IFS(A1=1,”Jan”,A1=2,”Feb”,A1=3,”Mar”)

If the return 
value is text, it 
must be wrapped within
quotation marks.
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Action 4 – IFS Function

Instructions: 
1. Open the Logical Formulas file.

2. Save the file as My Logical Formulas.

3. Click on the IFS Function sheet tab.

4. Select cell A2.

=IFS(A1=1,”Jan”,A1=2,”Feb”,

A1=3,”Mar”,A1=4,”Apr”, A1=5,”May”,
A1=6,”Jun”,A1=7,”Jul”, A1=8,”Aug”,

A1=9,”Sep”,A1=10,”Oct”,

A1=11,”Nov”,A1=12,”Dec”)

A1.

Results/ Comments:

6. Select cell 

5. Enter this formula, 

8. Save the file and leave it open.

7. Enter any value between 1 to 12.

This is the cell that the IFS formula is
checking.

As a value is entered the corresponding
month is returned in cell A2.



[Ctrl + S].

This is the first sheet in the workbook.

This will be the cell that tells us what month
is entered in cell A1.

Unlike a nested IF, the IFS function allows
up to 127 conditional to be checked within
the formula.
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Lesson 1: Logical & Lookup Functions

AND Functions

Primary IF formula

Nested AND formula

Value IF False

Value IF True

To perform multiple Logical Tests in an IF function, use the AND
function as the Logical Test of the IF. In the example below, if 
both conditions of the AND are true, then the IF returns the Value If
True. Should either of the AND’s Logical Tests not be true, then the
IF will return the Value If False.

Logical Test 1
If the value in cell F5 is greater than 5000 and the value in cell A5 
is equal to 10 then the formula will return a True value. If either 
of the values does not match the parameters of the Logical Tests in 
the AND function then the formula will return a False value.

There are times when you will need to check multiple cells to see if
they meet a set of parameters and return either a True or False
answer. If all the conditions are met then the formula will return 
a True value. If any of the conditions are not met then the formula
returns a False value. One common use for the AND function is 
to expand the usefulness of other functions that perform logical
tests. For example, the IF function performs a Logical Test and 
then returns one value if the test evaluates to TRUE and another
value if the test evaluates to FALSE. By using the AND function as
the Logical Test argument of the IF function, you can test many
different conditions instead of just one.

The AND function syntax has the following arguments:
  logical1: The first condition that you want to test 

that can evaluate to either a TRUE or FALSE value. A 
required argument.
  logical2: Additional conditions that you want to test 
which can evaluate to either a TRUE or FALSE value. 
An optional argument, there can be up to a maximum 
of 255 conditions.
The AND function is written like this:

FunctionLogical Test 2

Using an AND in an IF Function

=AND(F5>5000, A5=10)

=IF(AND(F5>5000,A5=10),F5*5%,0)
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Instructions: 
My Logical Formulas

Summary

F4

=AND(D4>1800,E4=”yes”)

Action 5 – AND Functions

F5:F14.

=IF(AND(D4>1800,E4=”yes”),

“Gold”,IF(AND(D4>1600,E4=”Yes”),
“Silver”,”Not Eligible”)) 

[Ctrl + Enter].

[Ctrl + S].

Results/ Comments:

then, press

9. Save the file.

8. Enter this formula 

4. Enter this formula, 

1. 
open. If not, open it.



2. Click on the 

3. Select cell .

5. Using autofill, fill cells 

 sheet tab.

 should still be 

6. Select cells F4:F14.

7. Click into the formula bar to edit the 
formula.

We are going to see if two conditions are
met in order to get a TRUE return.

This formula is to check if the commission
earned is above $1800 and if the content 
in cell E4 is Yes. If both conditions are 
met then the formulas will return a TRUE
value.

There should a mix of TRUE and FALSE

values in the cells.

We are going to edit all the cells.

Editing in the formula bar will allow us 
to apply the edit to all the selected cells

simultaneously by pressing [Ctrl + Enter].

This nested formula uses two AND’s in

two IF’s to check for multiple variables to

determine which membership level should

be returned. 
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Lesson 1: Logical & Lookup Functions

OR Functions OR Functions

Using an OR in an IF Function
This again can be nested in an
the IF function

Primary IF formula

Nested OR formulaValue If True

The IF formula will return the Value If True if either one of the 
OR formulas Logical Tests conditions is met. Should both the 
Logical Tests conditions not be met, then the IF will return the 
Value If False. 

 function to expand the scope of 

Value If False

While the AND function requires that all Logical Tests be true to
return a TRUE value, the OR function allows any of the Logical
Tests to return a true value for the formula to return a TRUE value.
You may have a situation where multiple conditions must be
checked. If any one is true, then the formula will return a TRUE
value. Use the OR function, one of the logical functions, 
to return a TRUE if any argument is TRUE. It returns FALSE if all
arguments are false.



The OR function syntax uses the following arguments:
  logical1: The first condition that you want to test that 
can evaluate to either TRUE or FALSE. A required 
argument.
  logical2: Subsequent logical values are optional. 1 
to 255 conditions you want to test that can be either 
TRUE or FALSE.




The OR function is written like this,
FunctionLogical Test 2

Logical Test 1
In this example, if either condition is true, the formula will return 
a TRUE value. Both conditions would have to be false for the 
formula to return a FALSE value. 

IF

OR 

=OR(F5>5000,A5=10)

=IF(OR(F5>5000,A5=10),F5*5%,0)
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Instructions: 
My Logical Formulas

Action 6 – OR Functions

Summary Tab.

F4 

F4 

F4 

F4 

Results/ Comments:

=OR(‘QT1’!F4>10000,’QT2’!F4>100
00,
’QT3’!F4>10000,’QT4’!F4>10000).
If any of these Logical Tests
the formula returns a TRUE

9. Save the file.

1. 
open. If not, open it.



2. Select cell G4 on the 

6. Double-click into the cell. 

 should still be 

3. Enter this formula 
=OR( 
Click on sheet QT1 and highlight cell 
and type: >10000 
press the [Comma] key 
Click on sheet QT2 and highlight cell 
and type: >10000 
press the [Comma] key 
Click on sheet QT3 and highlight cell 
and type: >10000 
press the [Comma] key 
Click on sheet QT4 and highlight cell 
and type: >10000 
then, press the [Enter] key



4. Use the autofill to put the formula into 
cells G5:G14.



5. Select cell G4 again.

7. Add these changes to the formula 
=IF(OR(‘QT1’!F4>10000,’QT2’!F4>10000, 

’QT3’!F4>10000,’QT4’!F4>10000), 
C4*0.07,C4*0.03) .



8. Use the autofill to put the formula into 
cells G5:G14.

If any of the sales team sold more than

$10,000 in a quarter they receive a 7%

bonus otherwise they receive a 3% bonus.

[Ctrl + S].

This is the cell where we will determine 
if this salesperson has exceeded a $10,000
total in any quarter, which will entitle

them to a higher bonus.

When finished the formula will read as 

There should a mix of TRUE and FALSE
values in the cells.

We will now nest the OR function in an IF
to determine the bonus level they earned.



To edit the formula in the cell instead of
the formula bar.

Add only the bold text to the formula.

 prove true then 
value.



Excel: Formulas, Rel. 6.0, /17/2020 Page 17

Lesson 1: Logical & Lookup Functions

NOT Functions NOT Functions

Using a NOT Function in an IF Function

Logical Test

If the value in cell F5 is less than 5000 then the NOT function 
will return a TRUE value. Should the value in cell F5 prove to 
be greater than 5000 then the NOT function will return a 
value.

Nested NOT formulaValue IF False
In the example above, until the value in cell F5 is above 5000 
the NOT formula will return a True result and return the Value 
If True argument of the IF. As the value in F5 is greater than 
5000 the NOT returns a False value and in turn the IF returns 
the Value if False argument of the IF statement. So you will 
know when the value in F5 is greater than 5000 when the cell 
containing the formula begins returning values instead of 0.

Use NOT functions when you want to make sure a value is not

equal to one particular value since this function reverses the

value of its argument. If the Logical Test is FALSE, NOT returns a

TRUE value; if the Logical Test is TRUE, NOT returns a FALSE

value. Unlike the AND or OR functions which can contain

multiple Logical Tests, the NOT only contains a single Logical Test.

The NOT function syntax has the following arguments:
  Logical Test: A value or expression that can be 
evaluated as TRUE or FALSE. A required argument.

The NOT function is written like this: 

Function

Use this combination when you are making sure a parameter you

define is not met in order to get a positive result. Once the NOT

logical test is met, the IF function will return the Value if False

argument of the IF formula.

Primary IF formulaValue IF True

FALSE 

=NOT(F5>5000)

=IF(NOT(F5>5000),0,F5*5%)
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H4.

Instructions: 
Logical Formulas 

Action 7 – NOT Functions

Results/ Comments:
1. 

not, open it.



2. Select cell 

8. Save the file.

5. Select cell H4.

3. Enter this formula 
= NOT(F4=”Gold”).

4. Use the autofill to put the formula into 
cells H5:H14.

6. Add these changes to the formula 
=IF(NOT(F4=”Gold”),”Yes”,”No”)



7. Use the autofill to put the formula into 
cells H5:H14.

should still be open. If 

Now only the Gold level members have a
NO value in the review column, all others
have YES values.



[Ctrl + S].

We now want to see if the salesperson

should be under review. 

If cell F4 contains the word Gold then the

NOT formula returns a FALSE, for any

other content in cell F4 the formula returns 
a TRUE.

Only Gold level members should have

FALSE values. These people do not require

reviews. 

We will modify the formula to return a

more easily understood response of YES or 
NO.

Add only the bold text to the formula.
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Lookup

Functions

There are many times where you will need to search for specific

data in the worksheet or workbook and the filters will not do.
Using lookup functions allows you to reach across worksheets to

look for the data you need. You can also add a data validation

list to the lookup cell to make the search much more efficient.

There are several lookup functions available to you 
  Vlookup: A vertical lookup, searches for a value in the 

first column of a table and returning the value in the 
same row in the column index number position in the 

table.

  Hlookup: A horizontal lookup, searches for a value in 
the first row of a table, and returns another value from 

the same column and row index number position in 
that table.

  Match: Searches for a specified item in a range of cells, 
and then returns the relative position of that item in 
that range.

  Index: Returns a value or the reference to a value from 
within a table or range. There are two forms of the 
INDEX function: the array form and the reference 
form.

  Array: Returns the value of an element in a table or 
an array, selected by the row and column number 

indexes. Use the array form if the first argument to 
INDEX is an array constant.
  Reference: Returns the reference of the cell at the 
intersection of a particular row and column. If the 

reference is made up of nonadjacent selections, you 
can pick the selection to look in.




The MATCH and INDEX functions, when used together can 
allow you to search a table like a VLOOKUP or HLOOKUP 
function when the lookup value is not held in the first column or 
row of a table or array. 
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VLOOKUP
Functions

VLOOKUP Function

The way this works is that the is compared to the first column of
the , this determines which row of the Table Array will contain
the desired information. Once that is established the specifies
what column of the 
Array will contain the desired information. The contents of the
cell at the intersection of the row and column will be the value
returned by the formula.

One thing to remember is that the Col Index Num argument in the
formula refers only to the table and not the worksheet, therefore
it doesn’t matter wherever the table is located. 

The VLOOKUP function is used to look up or search for a value

in a table. The VLOOKUP function will look at specified data 
in the first column of a table of data. Once found, it will return 
a result that is on the same row a specified number of columns
from the first column. When using this function, the values in 
the first column of the table must be in ascending order. For

example, you can search for the last name of a student in a list 
and then return a phone number from another cell on the same

row.

The VLOOKUP function syntax uses the following arguments:
  Lookup_Value—the Search Value
  Table_Array—the Range of the Lookup Table

  Col_Index_Num—an Offset to tell Excel how many 
columns to the right of the first column in the table 
it must look to find the result. 

  Range_Lookup—this is optional. This should be 
used only when searching for a text string and not a 
number. If you place the word “False”, this will tell 

it to find an exact match.



The function is written as
VLOOKUP :
 =VLOOKUP(Lookup_Value,Table_Array,Col_Index_Num)

Lookup Value
Table Array

Col Index NumTable 

Naming the 
range of cells 
that make up the 
Table_Array will make
lookup formulas much
easier to both write and
read. 



Excel: Formulas, Rel. 6.0, /17/2020 Page 21

Lesson 1: Logical & Lookup Functions

continued

Example of VLOOKUP

this is the Lookup value. This is the value that 
you are searching for (in this case the product #).

—this is the Table Array. It is the 
range of the Lookup Table (in this case, it is located on 
the worksheet with the data range being 
).

—this is the Col Index Number. This tells Excel what 
column to the right of the first column in the table 
array you want to extract information from (in this 
case, it is in the second column).

The example below shows how you can use the formula to look

up a description of a product on another sheet. 

This sheet is called 
MasterList. It lists all 
of the products that 
the company sells. It is 
important that the first 
column of data is sorted 
in ascending order for the 
VLOOKUP to work. 

This sheet is called Sales. The 
VLOOKUP formula is placed 

in cell B2. This will bring 
over the description of the 
product when you type in 
the account code in cell A2. This is a great function to use because
you will not have to type out the product description. It will be

brought in automatically from the MasterList. You can also use

the formula to automatically bring over the Price Per Unit and

place it in Column D.

The formula in the above example is:
 =VLOOKUP(A2,’Master List’!A2:C9,2)

  A2 —



  'Master List’!A2:C9

Master List
A2:C9
  2

VLOOKUP
Functions,

Vlookup formula 
will look for 
Product # 101234 
in the Master List Sheet
and places the Product
description in cell B2 in
the sales sheet.

This is how the formula would be 
entered in the Function Arguments dialog


box.
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D12

Instructions: 
1. Open the MyLoan

2. Select cell I5 (Rate

D13 4.25%

[Enter].

 #NA. 

Action 8– Vlookup Function

Indiana

<Oh>.

=VLOOKUP(Years,Table,IF(State=”OH”,
3,2))

Results/ Comments:

8. 

9. 

 Select cell 

In cell , type:
then, press 

3. Enter this formula 

4. The formula returns a

 file.

).

, and type: 

5. Select cell B6 (State) and enter


6. Select cell I7 (Years).

7. Enter a number between 1 to 10. This will complete adding values that the

VLOOKUP needs and the formula in I5

(Rate) now returns a value.

The header for this column is added.

We will begin adding the values for

Indiana’s interest rates.

This is the first value.

This is where the interest rate will be
displayed. Two factors must be considered
to find the correct rate, the state and
number of years the loan is for.
We will use the VLOOKUP formula 
to find which row in the Interest Table
contains the correct rate based on the
number of years. 
Since there are three different columns 
to possibly choose from depending on
which state the loan is being issued in, it
will be necessary to nest an IF within the
VLOOKUP.

At this point the formula can only return 
a value if the state is equal to either Oh 
or Mi, since the table name refers to cells
A13:C22. The values for Indiana need to 
be added to the Interest table and its
name redefined.



This is because there currently is no value
in cell I7 (Years) for the formula to find.



To set a value that the formula can find.
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Instructions: 
D14, 4.75%
[Enter]



D13:D14

D22

MA

Action 8– Vlookup Function, continued

Results/ Comments:

21. Save the file.

20. Change the value in the State cell to 

10. In cell type: 
then, press .



11. Select cells and use the autofill 
to populate values to cell .

17. Select cell I5 (Rate).

18. Add these changes to the formula 
=VLOOKUP(Years,Table,IF(State=”OH”, 

3,IF(State=”Mi”,2,IF(State=”IN”,4,5))).



19. Change the state to either Mi or In to test
the VLOOKUP formulas functionality.

12. Select cell E13 and enter 
Out of Region 
Autofill it down to cell E22.



13. Click the [Name Manager] button in the


Defined Names Group on the Formulas 
Tab.



14. Select the Table name and click the [Edit] 
button.



15. Click into the Refers to: field and change


the $C$22 reference to $E$22. Click the 
[OK] button.



16. Click the [Close] button.

This is the second value.

At this point, we will redefine the Table
name to include the newly added data.
The Name Manager dialog box opens.

The Edit Name dialog box opens for the
selected name.

By changing the cell address from C22 to
D22, we have expanded the reference to
include the new data.



The Name Manager dialog box is closed
and the name has been updated.

We will now edit the formula.

Add only the bold text to the formula.

The results in cell I5 (Rate) should change
according to the state entered. You may

need to increase the number of decimal

places for this cell.

This state is not part of the table and will

return an “Out of Region” in the formula. 

[Ctrl + S].

Selecting both cells with values
establishes the series that autofill will use
to populate the remaining cells.



This will be the return if no listed state is
found by the formula.
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HLOOKUP Function
The HLOOKUP function is used to look up or search for a value
in a table. The HLOOKUP function will look at specified data in
the first row of a table of data. Once found, it will return a result
that is on the same column a specified number of rows from the
first row. 



The HLOOKUP function syntax uses the following arguments:
  Lookup_Value—the Search Value
  Table_Array—the Range of the Lookup Table

  Row_Index_Num—an Offset to tell Excel how many 
rows down from the first row of the table it must look 

to find the result. 

  Range_Lookup—This is optional and should be used 
only when searching for a text string, not a number. If 

you place the word “False”, this will tell it to find an 
exact match.




The function is written as:

Look at the spreadsheet below, in this example we are trying 
to lookup the letter grade for each student. The formula in C2 
is =HLOOKUP(B2,$E$4:$M$5,2). Excel will look in Column B 
for the Grade percentage then look in the first row of the table

(E4:M5) and then place the grade that appears in the second row
of the table into Column C. 

Notice how if the value is not found exactly, Excel knows that it is

within the range. For example, it wasn’t able to find the value 99,

but it still brought back a letter grade of “A+”. Excel was able to

determine that it was within a range and any number within that

range will return a certain letter grade. 

HLOOKUP
=Hlookup(Lookup _Value,Table_Array,Row_Index_Num)

HLOOKUP
Function

The Formula for HLook-
up is in cell . C2 =HLOOK-
UP(B2,$E$4:$M$5,2)
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I2.

Sales

Instructions: 
1. Open the Discount

A2:F3

Table.

=HLOOKUP(H2,Table,2).

Action 9– Hlookup Function

My Discount

Discount Table 

Results/ Comments:
HLOOKUP

6. Click the 

7. Select cell 

2. Save the file as

3. Click the 

4. Select cells . 5.

Name the range 

8. Enter this formula 

 sheet.

 file.

sheet.

9. Double-click the Autofill handle.

10. Select cell J2 and enter the following 
formula 
=H2-(H2*I2) .



11. Select cell J2, Autofill and format the 
column for currency.



12. Save the file.

We will be using the to

compare the sales total to a table that

outlines the discounts to determine how

much of a discount the sale is eligible for.

Using the Autofill completes this column
of data in the worksheet.



[F12].

Use the Name Box to apply the name to
the cell range.

This is the sheet that we need the
HLOOKUP formula on.

This is the cell that requires the formula to
see what discount is to be applied to the
sale.

The value in H2 will be compared to the
first row of the Table and when a match is
found the value from the second row will
be returned.

Since the formula is in a cell directly
adjacent to the data, the Autofill runs 
down the column up to the first blank row
is encountered.



Now we need to calculate what the
discounted price will be.

This is the sheet that has the discount
table data.
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Data Validation
List

Data Validation List

Creating a Data Validation List
   Click the [Data Validation] button in the Data Tools 

Group on the Data Tab.

 In the Data Validation dialog, select the Settings tab.

 Click the drop-down for the Allow field and choose 
List.

 Click into the Source field. There are two ways that a 
list can be entered: by selection or manually typing it 

in.

  Selection: click the [Expand/Collapse] button at 
the right edge of the field. Then select the cells that 

contain the list entries. Click the [Expand/Collapse] 
button again to redisplay the Data Validation dialog 

box.

  Manual Entry: Type each list entry. Separate each 
entry with a comma. 

While it is not necessary, you can also click the Input 
Message tab and add a message that will be displayed 

when the cell is selected.

 If you do not want to allow an entry that is not on the 
list, click the Error Alert tab. Set the Style field to Stop. 
While it is not necessary, you can add a message that 

will be displayed if invalid data is entered.
 Click [OK].

If you want to be able to select what you are looking for from a

list, then this feature will prove invaluable. This tool does not

filter the data in any way, but will populate the cell with choices

made from the list and use only unique values in the list. The cell

can be referred to as the Lookup Value argument of a VLOOKUP 
or any other formula that uses a Lookup Value argument, which

makes the retrieval of data much simpler.
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Instructions: 
My Discount 

[Data Validation]
Data Tools Group on the Data Tab

Action 10 – Setting Up Drop-down Lists

[Ctrl + S].

Results/ Comments:

3. Click the 

4. In the Settings tab of the Data Validation 
dialog box, choose List from the Allow: 
drop-down.



5. Click into the Source: field 
Select cell A8, and hold both the [Ctrl + 
Shift] keys 

Tap the down arrow key once, then click 
the [OK] button.



6. Select cell D2.

 button in the 
.

7. Click the [Data Validation] button in the 
Data Tools Group on the Data Tab.



8. In the Settings tab of the Data Validation 
dialog box, choose List from the Allow: 
drop-down.



9. Click into the Source: field, 
Select cell B7, and hold both the [Ctrl + 
Shift] keys 
Tap the right arrow key once, then click 
the [OK] button.



10. Test the drop-down lists, then save the 
file.

1. should still be open. If not, 
open it.



2. Click on the Advanced Search sheet tab 
and select cell D1.

Since the worksheet has all the entries
already listed, we can use those cell

addresses.

We will now get the drop-down list of the

Percentages using the same technique as

above.

We will now search through a much larger
list of possible discount variables.



To make this much easier to find, we will
now add drop-down lists to ensure that
users will search for only valid data.

The Data Validation dialog box opens. We
will not worry about the Input Message
and Error Alert tabs.

This is the option that allows us to create
drop-down lists.
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MATCH Function

The 

When the Lookup Value you are searching for is not held in the 
first column or row of a Table Array, the MATCH function will
search for a specific value within a range of cells and return the

position of the Lookup Value within the range. 

Use MATCH instead of one of the LOOKUP functions when you

need the position of an item in a range instead of the item itself.

For example, you might use the MATCH function to provide a

value for the row_num argument of the INDEX function.

 function syntax has the following arguments:
 A required argument. The value that 
you want to match in the Lookup_array. For example, 
when you look up someone’s number in a telephone 

book, you are using the person’s name as the lookup

value, but the telephone number is the value you want.

  The Lookup_Value argument can be a value (number, 
text, or logical value) or a cell reference to a 
number, text, or logical value.

 Lookup_Array: A required argument. The range of 
cells being searched.
 Match_Type An optional argument. The number -1, 

0, or 1. The Match_Type argument specifies how Excel 
matches the Lookup_Value with values in the Lookup_
Array. The default value for this argument is 1.

  1= finds the largest value that is less than or equal 
to the Lookup_Value. The values in the Lookup_Array 

argument must be placed in ascending order.

  0= finds the first value that is exactly equal to 
the Lookup_Value. The values in the Lookup_Array 
argument can be in any order.

  -1= finds the smallest value that is greater than or 
equal to the Lookup_Value. The values in the Lookup_

Array argument must be placed in descending 
order.

MATCH
  lookup_value:

 

 

MATCH Function
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MATCH

Function,
continued

The  function is written like this;

Function
Lookup Array

Lookup ValueMatch Type

In this example, the range A1:A3 contains the values 5, 25, and 38 
respectively. The formula returns the number 2, because 25 is the 
second item in the range.

Match

=MATCH(25,A1:A3,0)
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H1.

H2.

Instructions: 
My Discount 

Action 11 – Creating a Match Function

Results/ Comments:
1. 

open it.



2. Select cell 

5. Select cell 

8. Save the file.

3. Enter the following formula, 
=MATCH(D1,A8:A34,0) .

6. Enter the following formula, 
=MATCH(D2,B7:V7,0) .

should still be open. If not, 

4. Select cell D1 and choose any value from 
the drop-down list.

7. Select cell D2 and choose any value from 
the drop-down list.

We want to find out what row contains the
value we are looking for. 



The formula will first check to see what
value is in cell D1. Then it will take that
value and compare it to what is in the cell
range, A8:A34. Since we are searching for
exact matches, the third element of the
formula is set to 0.

As the value changes, our formula tells us
what row number we can find that value in.

This time we will be looking for the 
column number that holds the percentage.

The formula will first check to see what
value is in cell D2. Then it will take that
value and compare it to what is in the cell
range, B7:V7. Since we are searching for
exact matches, the third element of the
formula is set to 0.

As the value changes, our formula tells 
us what column number we can find that
value in.

[Ctrl + S].
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INDEX Function INDEX Function

INDEX Array Form

The INDEX function can return a value or the reference to a value
from within a table or range. You can refer to both the column
and/or row within the cell range. You can use the results of a
MATCH function as the Lookup Value to pull data from another
column along the row defined by the MATCH.

There are two forms of the INDEX function: the array form and
reference form.

Returns the value of an element in a table or an array, selected by
the row and column number indexes.



Use the array form if the first argument to INDEX is an array 
constant.
The INDEX function syntax has the following arguments:

  Array: A required argument. The range of cells or a 
constant array of cells that are being searched.

  If the array contains only one row or column, the 
corresponding Row_num or Column_num argument 

is optional.

  If array has more than one row and more than 
one column, and only Row_num or Column_num is 
used, INDEX returns an array of the entire row or 
column in array.
  Row_num: A required argument. Selects the row in 
the array from which to return a value. This can be 
considered the Lookup Value that is being searched for 
within the Array. You can refer to the cell containing 

the MATCH function. If Row_num is omitted, Column_
num is required.

  Column_num: An optional argument. Selects the 
column in the array from which to return a value. 
This can be considered the Lookup Value that is being 
searched for within the Array. You can refer to the cell 
containing the MATCH function. If Column_num is 
omitted, Row_num is required.
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INDEX Function,
continued

If both the and arguments are used, 
returns the value in the cell at the intersection of 
and .

Returns the reference of the cell at the intersection of a particular

row and column. If the reference is made up of nonadjacent

selections, you can pick the selection to look in.

The INDEX function syntax has the following arguments:
  Reference: A required argument. A reference to one or 
more cell ranges, defines the area that contains the raw 

data to search through.
  If you are entering a nonadjacent range for the 
reference, enclose reference in parentheses. 
=INDEX((reference,reference),row_num)
  If each area in reference contains only one row or 
column, the Row_num or Column_num argument, 
respectively, is optional. For example, for a single 
column reference, use 
=INDEX(reference,column_num).
  Row_num: A required argument. The number of the 
row that contains the data wanted from within the 
referenced range of cells.

  Column_num: An optional argument. The number of 
the column in reference that contains the data wanted 
from within the referenced range of cell.

  Area_num: An optional argument. If there is more 
than one reference in the formula, this defines which 

of the references from which to return the intersection 
of Row_num and Column_num. If Area_num is omitted, 

INDEX uses area 1. 

For example, if Reference describes the cells (A1:B4,D1:E4,G1:H4)
Area_num 1 is the range A1:B4
Area_num 2 is the range D1:E4
Area_num 3 is the range G1:H4.

The INDEX function is written like this:
=INDEX(array, row_num, [column_num])




Row_num Column_num
INDEX
num Column_num

Row_

INDEX Reference form

Row_num and 
Column_num must 
point to a cell 
within array; otherwise,

INDEX returns the

#REF! error value
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INDEX Function,
continued

After and have selected a particular range, 
and select a particular cell: 1 is 
the first row in the range, 1 is the first column, and so on. The
reference returned by is the intersection of 
and .



If you set or to 0 (zero), returns 
the reference for the entire column or row, respectively.

Row_num, Column_num, and Area_num must point to a cell 
within reference; otherwise, INDEX returns the #REF! error value.
If Row_num and Column_num are omitted, INDEX returns the
area in reference specified by Area_num.

The result of the INDEX function is a reference and is interpreted
as such by other formulas. Depending on the formula, the return
value of INDEX may be used as a reference or as a value. For 
example, the formula CELL(“width”,INDEX(A1:B2,1,2)) is 
equivalent to CELL(“width”,B1). The CELL function uses the
return value of INDEX as a cell reference. On the other hand, a
formula such as 2*INDEX(A1:B2,1,2) translates the return value
of INDEX into the number in cell B1.

This type of INDEX function is written like this:
=INDEX(reference, row_num, [column_num], [area_num])

Reference Area_num
Row_numColumn_num Row_num
Column_num
INDEX
Row_num Column_num

Row_num Column_num INDEX



Excel: Formulas, Rel. 6.0, /17/2020
Lesson 1: Logical & Lookup Functions, Page 34

C4.

H3.

Instructions: 
My Discount 

=INDEX(B8:V34,

MATCH(D1,A8:A34,0),
MATCH(D2,B7:V7,0))

D1

Action 12 – Creating an INDEX Function

Results/ Comments:
1. 

open it.



2. Select cell 

5. Select cell 

 .

7. Save and close the file.

3. Enter the following formula, 
=INDEX(B8:V34,H1,H2) .

6. Enter the following formula, 

4. Try changing the values in cells 
D2.

 and 

should still be open. If not, 

Now we want to look for the value in the
cell that lies at the intersection of the row
and column numbers we found using the
MATCH functions. 

This formula first defines the area where
we are looking for data. Then the row
number that is being returned by the
MATCH in cell H1. The last element of 
this formula is the column number which is
again being returned by the MATCH in cell
H2.



Both the INDEX and MATCH functions are
updated based on the choices made from
the drop-down lists in cells D1 and 
D2.

Now, we will nest MATCH functions inside
and INDEX to accomplish the same result
in a single cell with a single formula.

In this INDEX formula, a MATCH 
formula is replacing the row and column
elements of the formula. We are running
multiple checks in one place.

[Ctrl + S] and [Ctrl + W].
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Using the Advanced Filter

This dialog box allows you to choose the range of cells to filter 
for specific items and either filter the data in place or place the

filtered list in a location of your choosing. It can also find unique

values in the define list range.

The following buttons allow you to choose how the results of the 
filter will be handled.

  If Filter list in place is selected, then the Copy To: field is 
grayed out. 
  If Copy to another location is selected, then the Copy to: 
field is available.
  If you are looking to create a list of unique values, 

check the Unique records only checkbox. Since the search 
is for unique values only, there is no need to enter 
anything into the Criteria range: field. 

When starting to work on a new file, the data may come to you as

a CSV file or simply as raw data in an Excel file. In this case, you

may want to extract information out of the raw data to format

information that you need. Instead of searching for individual

records then copying and pasting them one at a time, it is more

effective to spend a little time preparing the file and using the

Advanced Filter. 

Once the file is open, click on the Data Tab and look in the 
Sorting & Filtering Group of commands for the [Advanced] 
button. Once the button is clicked the Advanced Filter dialog box

will open. 

Filtering Data for
Unique Values
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Instructions: 
Sumif.

My Sumif

[Advanced]
& Filter GroupData Tab

Sort 

Action 1 - Advanced Filtering and Naming cell ranges

Results/ Comments:

11. Click the 

1. Open the file 

2. Save the file as 

 button in the 
on the .

3. Select cell A2, and hold [Shift + Ctrl] 
keys. Tap the down arrow key once.



4. Click into the NameBox and type: 
Customer.



5. Select cell C2, and hold [Shift + Ctrl] 
keys. Tap the down arrow key once.



6. Click into the NameBox and type: 
Salesperson. Press the [Enter] key.



7. Select cell J2, and hold [Shift + Ctrl] keys. 
Tap the down arrow key once.



8. Click into the NameBox and type: 
QTY. Press the [Enter] key.



9. Select cell K2, and hold [Shift + Ctrl] 
keys. Tap the down arrow key once.



10. Click into the NameBox and type: 
Sales. Press the [Enter] key.

The range is now named to be used in our
formulas.

This file contains the raw data that we 
need to extract information from, but as

you can see it would take a very long 
time to figure out who sold how much 
to whom. Before we start, naming and

filtering the cell ranges will help speed the

process up.

The entire column of customers is selected.

Now main ranges needed for our formulas
are named.



The first thing we need is to extract a list of
the Salespeople.



The Advanced Filter dialog box opens.
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N1

[OK]

[OK]

Copy to:

Instructions: 

location

List range:
$C$1:$C$2156

Unique Records Only 

Copy to another 

[Advanced]Sort 
& Filter GroupData Tab

Copy to another 
location
List range: field enter 
$A$1:$A$2156
Copy to: field enter 
N15
Unique Records Only 

[Ctrl +S]. 

Action 1 - Advanced Filtering and Naming cell ranges, continued

Results/ Comments:
Excel

13. In the 

14. In the 

19. In the 

20. In the 

16. Click the 

15. Check the
checkbox.

21. Check the 
checkbox.



22. Click the 

23. Save the file.

12. Click the button to 

 button.

 button.

 field enter 

 field enter 

17. Click the button in the 
on the .



18. Click the button to 

We will now extract a full list of the
customers.

This allows to place the results of the
filter in a location of your choosing.



This is the range of cells to be filtered.
Include the header row since the filter will
automatically take the first entry as the
header of the list.

This is where we will place the list.

We will get only unique values returned

and it also negates the need to define what
is being searched for by the filter.

Now a complete list of the salespeople is

displayed in cells N1 through N10.
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Using the SUMIF Formula

This translates as: Search the range of cells named
Salesperson for any instances of text Smith and add only
those rows in the column named Sales. 



The SUMIF function will return incorrect values if you try
matching strings of more than 255 characters.

This formula saves a lot of time when there is a specific subset 
of data that needs to be totaled. You may have found that you

sorted the data by a subset value to run a calculation but when

the data is resorted the calculated values were off. This is because
the formula used a cell range but those values change in relation

to sorting and resorting. To avoid this issue, use the Sumif

formula since it will only calculate a result based in specified

criteria from within your overall data set.

There are three arguments required in the SUMIF function:

  Range: required - the range to search for the specified 
criteria

  Criteria: required - what is being searched for within 
the specified search range
  Sum_Range: optional - once the criteria is found for 
each row, sum the data from this range
As an example, should you require a total of all sales made by a 
salesperson, but the data is sorted by sale date or time. The first 
thing to consider doing would be to select the column containing 
all the salespersons names, excluding the column header, and 
apply a name to the range of cells. Click into the Name Box and 
type in a name that is clearly descriptive of the content (in this 
case, Salesperson would be a good choice). Then select and name 
the range relating to sales totals. Once the ranges are named you 
can easily refer to the names instead of having to highlight those 
ranges.
For more explanation of Naming, refer back to the Naming 
section of Lesson 1. 

=SUMIF(salesperson,”smith”,sales)

=SUMIF(Range,Criteria,[Sum_Range])

SUMIF Functions

When entering 
the criteria, if the 

criteria is text or a

mathematic expression 
it must be wrapped 
in quotation marks.

You can also use a cell

reference as a criteria.

In this case, using 
names to specify 
ranges will prove 
much easier than trying
to select the cell
ranges. 
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Instructions:
MySumif

Action 2 - Using SUMIF to create totals

Results/ Comments:

4. Enter the following formula: 
=SUMIF(Salesperson,$N2,Sales) 

press the [Ctrl +Enter] key combination.

5. Use the autofill handle to fill in cells 
O3:O10.



6. Select cell P1 and type: 
Units Sold 
then, press the [Enter] key.

7. Select cell O2 and use the autofill handle 
to pull the formula into cell P2.

1. file should still be open. If not, 
reopen it.



2. Select cell O1 and type: 
Sales Total 
then, press the [Enter] key.



3. Select cell O2, if necessary.

8. Select cell P2 and Double-click into the 
cell to edit the formula.



9. Change the Sales name to QTY and press 
the [Ctrl + Enter] key combination.

Another header is set in place.

The header is added to this cell.

You will copy this formula into cell 
P2. Making the criteria use an absolute

column and relative row address allows

the formula to be dragged into other

columns but still refer to the correct

column in the formula. 

The cell now displays its formula.

Now the formula will total the number of
units sold by the salesperson on this row.

This will be where the formula will be

added.

The formula will examine the range 
named Salesperson for every instance of

the name in cell N2 (use the [F4] key to set
the column as absolute). Once those are

found it will sum only those instances in

the Sales range. Using the [Ctrl +Enter]

key combination applies the formula and

keeps the cell active.

Click and drag down to cell O10.
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Instructions: 

Action 2 - Using SUMIF to create totals, continued

[Ctrl +S].

Results/ Comments:
10. Use the autofill to complete the totals for 
the remaining salespeople.



11. Select cell O15 and type: 
Sales Total 
then, press the [Enter] key.

12. In cell O16, enter the following formula: 
=SUMIF(Customer,$N16,Sales) 
then, press the [Ctrl +Enter] key 
combination.

13. Use the autofill handle to fill in cells 
O17:O104.



14. Try creating another column that 

calculates how many units each customer 
has purchased. 



15. Apply any desired cell formatting.

16. Save the file.

The formula will examine the range
named Customer for every instance of
the name in cell N16 (use the [F4] key to
set the column as absolute). Once those
are found it will add only those instances
in the Sales range. Using the [Ctrl
+Enter] key combination applies the
formula and keeps the cell active.

Double-click the autofill handle to run the
formula down as many rows as needed.



Repeat steps 7 through 10 to fill cells 
P15:P104.

Now you know how many units were sold
by each salesperson.



Here we want to see how much each
customer has purchased.
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Using the AVERAGEIF Formula
This formula uses the same syntax as the SUMIF formula
but returns an average derived from the specified criteria.

 required - the range to search for the specified 
criteria

required - what is being searched for within 
the specified search range
 optional - once the criteria is found 
for each row, average the data from this range

 If the cells in range contain TRUE or FALSE values, 
they are ignored.

 Empty cells within the average_range will be ignored 
by the AVERAGEIF function.
 AVERAGEIF will return the #DIV0! error if the range 
is blank or has text values.
 Empty cells within the criteria are treated as 0 by the 
AVERAGEIF function.
 When the AVERAGEIF does not find any matches to 
the criteria it will return a #DIV/0! error.
 You can use the wildcard characters within the criteria 
in this formula.
 Average_range and Range do not have to be of the 
same size. The formula uses the top-left cell in the 
Average_range as the starting point, it then adapts to 

meet the size of the Range.

=AVERAGEIF(Range,Criteria,[Average_Range])

 Range:

 Criteria: 

Average_Range:

 

 

 

 

 

 

 

 

 

 

Things to keep in mind when using this formula: 

AVERAGEI
F Function

In criteria, a 
question mark 

(?) matches any 
single character and an

asterisk (*) matches any
sequence of characters.
If you want to find an

actual question mark or

asterisk, type a tilde (~)

before the character.
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Instructions:
MySumif

Action 3 - Using the AVERAGEIF formula

Results/ Comments:

3. Enter the following formula: 
=AVERAGEIF(Salesperson,N2,Sales) 
then, press the [Ctrl +Enter] key 
combination.



4. Use the autofill to fill in the remaining 
salespeople’s values.
5. Select cell Q15 and type: 
Average Purchase 
then, press the [Enter] key.

6. In cell Q16, enter the following formula: 
=AVERAGEIF(Customer,N16,Sales) 

then, press the [Ctrl +Enter] key 
combination.
7. Use the autofill to fill in the remaining 
Customers values.
8. Save the file.

1. file should still be open. If not, 
reopen it.



2. Select cell Q1 and type: 
Average Sales 
then, press the [Enter] key.

This returns the average purchase of the
customer listed in cell N16.

The next header is added to the
spreadsheet. Adjust the column width 
by placing the cursor between columns 
Q and R, in the column header area. 
When the horizontal double arrow cursor
is displayed, Double-click the line that
separates the columns.

This formula will return the average sale
for the salesperson on this row.

Now you know what each salesperson’s
average sale is.

You are beginning to create another
subset of calculated data here.

Now you know the average purchase each
customer makes.



[Ctrl + S].
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COUNTIF
Functions

Using the COUNTIF Formula

 where to count what will be searched for by 
the criteria.

what is to be searched for and counted within 
the range.

In the file we have been working on, we have successfully been
able to calculate several important data points in relation to
both the sales staff and customers. Now we need to know how
many sales each salesperson has made, as well as how many
times each customer has made an order. To get this information
we will use the COUNTIF formula.

This formula will work the same way as the previous formulas.
The syntax of this formula differs in one way only. It does not 
use the optional third argument. Both arguments in this formula
are required. 

 Range:

 Criteria: 

=COUNTIF(Range,Criteria)
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Instructions: 
MySumif

Action 4 - Using the COUNTIF formula

[Ctrl + S].

Results/ Comments:
1. file should still be open. If not, 
reopen it.



2. Select cell R1 and type: 
Number of Sales 
then, press the [Enter] key.

3. In cell R2, enter the following formula: 
=COUNTIF(Salesperson,N2) 
then, press the [CTRL + Enter] key 
combination.
4. Use the autofill to complete the counts 
for the remaining salespeople.
5. Select cell R15 and type: 
Number of Purchases 
then, press the [Enter] key.

6. In cell R16, enter the following formula: 
=COUNTIF(Customer,N16) 
then, press the [CTRL + Enter] key 
combination.
7. Use the autofill to complete the counts 
for the remaining customers.
8. Adjust the width of column R to show all 
the contents.
9. Save the file.

The new header is placed.

The next header is placed.

Now you are counting the number

of times the customer appears in the
Customer range.

The other salespeople’s values are filled in.

This formula will count the number

instances the name in cell N2 occur within
the Salesperson range.

We now know how often the customer has
made a purchase.



The column is now fully displayed.



Excel: Formulas, Rel. 6.0, 02/17/2020 Page 47

Lesson 2: Complex Summing Functions

SUMIFS

Functions

Using the SUMIFS Formula
Summing by one subset of data is extremely useful. There may

come a time when you will need to add more subsets to even

further refine the data coming out of your raw data. This is done 
by using the SUMIFS, AVERAGEIFS, or COUNTIFS. These 
functions allow you to search for multiple criteria in multiple

ranges.

We need to make calculations based on multiple criteria. In 
the file we have been working on, you may need to know who

made sales that met or exceeded target goals. This is where the

SUMIFS function comes into play.

The syntax for this formula is:

In this formula:
  The first criteria argument defines the range containing 

the data to be summed. Unlike a SUMIF the Sum_
Range is no longer an optional argument.

  The first range defines what will be searched.

  The first Criteria defines what will be searched for 
within the first range. 
  The subsequent Range and Criteria pairs will narrow 
the results to a fine point.
There can be up to 127 Range and Criteria pairs used in a single 
SUMIFS formula. The AVERAGEIFS formula uses the same 
syntax as the SUMIFS.

=SUMIFS(Sum_Range,Range,Criteria,

Range,Criteria)
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Using the COUNTIFS Formula
The easiest method to determine the number of instances

something occurs within a given set of parameters is to use 
the COUNTIFS function. Since this formula can have multiple

Range and Criteria pairs it allows you to do very precise counts. 

The syntax of this formula is:

The second pairing would search within the number of items

sold range for a specified amount. Here you can use mathematic
expressions to boost the functionality of the formula. When

including a mathematic expression in these formulas, you must

wrap the expression in double quotes. This is also true if the

criteria is a text value.

  The first range will be where the count is run.

  The first criteria is what is being searched for 
within the range.

  Subsequent Range and Criteria pairs further refine 
the search results based on their definitions. 
If you needed to know how many sales were made by a sales 
representative that met or exceeded a target goal, you would use 
a COUNTIFS formula. The first Range and Criteria pair defines 
the primary information needed. In this case you may want to 
find the desired salesperson from that range.

Range Criteria

Second Range

First Range and Criteria Pair
Second Criteria, using mathematic expression

=COUNTIFS(Salesperson,Name,

=COUNTIFS(Range,Criteria,Range,Criteria,...)

COUNTIFS
Functions

=COUNTIFS(Salesperson,Name,QTY,”>10”)
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Instructions:
MySumif

T1 
# of Sales Above 10 
[Enter] 




T2,
=COUNTIFS(Salesperson,N2,QTY,”>10”) 
[CRTL + Enter]

[Ctrl +S].

Action 5 - Using the SUMIFS and COUNTIFS formulas

Results/ Comments:

7. Use the autofill to complete the 
calculations for the remaining 
salespeople.



8. Save the file.

4. Use autofill to complete the calculations 
for the other salespeople.



5. Select cell and type: 

then, press the key

6. In cell enter the following formula: 

then, press the key 
combination.

1. file should still be open. If not, 
reopen it.



2. Select cell S1 and type: 
Sales above 10 
then, press the [Enter] key.

3. In cell S2, enter the following formula: 
=SUMIFS(Sales,Salesperson,N2,QTY, 
“>10”) 
then, press the [CRTL + Enter] key 
combination.

The next header is in place.

Now we will start to breakdown the data

into subsets that will offer a more in depth
understanding of the data.

This will count the number of cells that

have a value greater than 10 within the

QTY range only if the name Salesperson

range match the criteria. You now can see

how many sales of more than ten units

were made by each salesperson. 

This formula will add the values in the

sales column only if both conditions are

found to be true. The name in cell N2 is

found in the Salesperson range and the

number for the record is higher than ten in

the QTY range.
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Instructions:
MySumif

U1
Sales between 5 and 9 Units
[Enter]



U2,
=COUNTIFS(Salesperson,N2,
QTY,”<10”,QTY,”>=5”) 
[Ctrl + Enter]

Action 6 - Adding more criteria to a COUNTIFS formulas

Results/ Comments:

then, press
the
combination.

then, press
the
combination.

4. Use the autofill to complete the 
calculations for the remaining 
salespeople.



5. Select cells E2:E2156.

 key 

6. Click into the Namebox, enter: 
Order_Date 
then, press the [Enter] key.

7. Select cell S14, and type: 
Number of purchases by month 
then, press the [Enter] key.

8. In cell S15, type: 
Jan 
then, press the [Enter] key.

9. In cell S16, enter the following formula: 
=COUNTIFS(Customer,N16, 
Order_Date ,”>=1-1-2015”, 
Order_Date,”<=1-31-2015”) 
[CTRL + Enter] key 

1. file should still be open. If not, 
reopen it.



2. Select cell and type: 

then, press the key.



3. In cell enter the following formula: 

The new header is added.

This formula is going to count the records

for the customer listed in cell N16 if they

made an order between Jan 1, 2015 and 
Jan 31, 2015.

This formula will narrow the search by
adding a third Range and Criteria pair. 
It will search the same range twice, first 
to find values below 10 and then for any
values ‘equal to and above’ 5 within the 
QTY range but count only those records
matching the salespersons’ name in cell 
N2.

You now see how many sales of between
5 and 9 each salesperson made.

Select cell E2, hold down both the [Shift +
CTRL] keys and press the down arrow key
once to quickly select the range.

Since you will need to use this range for 
the next formula, it is a good idea to name
the range.



You are adding in another header to define
an area where you are going to track
purchases by month.

The first month header.
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Instructions: 

T16

[Ctrl + S].

Action 6 - Adding more criteria to a COUNTIFS formula, continued

Results/ Comments:

=COUNTIFS(Customer,N16, 
Order_Date ,”>=2-1-2015”, 
Order_Date,”<=2-28-2015”)

10. Try creating another COUNTIFS in cell 
to find the number of orders each 
customer made in February.



11. Select cells S16:T16 and use the autofill to 
fill in each customer’s monthly order.



12. Save the file.
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=MAXIFS(Max_Range,Criteria_
Range1,Criteria,


[Criteria_Range2],[Criteria],....)

MAXIFS 
and MINIFS
Functions

The MAXIFS and MINIFS functions will return either the

highest or lowest value from a range of cells based on criteria

you define. These functions are similar to SUMIFS, and

AVERAGEIFS functions except that these functions can be run

with a single criteria range and criteria pair or up to 127 criteria
pairs.

The syntax of these formulas is;

 The first argument defines where the highest or 
lowest value will be pulled from, depending on 

which function is being used.

 The first Criteria_Range defines where the criteria 
will be searched for. 
The first Criteria is what is being searched for 
within the criteria range.
 Subsequent Criteria_Range and Criteria pairs 
further refine the search results based on their 
definitions.
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Instructions:
MySumif

X1
Lowest Sale Value.

X2

W1
Highest Sale Value.

W2

Action 7 - Using the MAXIFS and MINIFS Functions

[Ctrl + S]

Results/ Comments:

[Ctrl + W].

3. Select cell .

4. Enter the following formula; 
=MAXIFS(Sales,Salesperson,N2) 

then, press the [CTRL + Enter] key 
combination.



5. Use the autofill to complete the 
calculations for the remaining 
salespeople.



6. Select cell and enter: 

7. Select cell .

8. Enter the following formula; 
=MINIFS(Sales,Salesperson,N2) 

then, press the [CTRL + Enter] key 
combination.
9. Use the autofill to complete the 
calculations for the remaining 
salespeople.

10. Save and close the file.

1. file should still be open. If not, 
reopen it.



2. Select cell and enter: 

 and 

The new header is added.

The new header is added.

Now you know the value of each
salespersons best sale.

Each salespersons’ lowest sale value
is shown.

This formula will find the highest value
in the Sales column of data based on
the Salesperson.

This formula will find the lowest value

in the Sales column of data based on the
Salesperson.



Tips and Notes



Lesson Overview

Excel:
Formulas 6.0,
02/17/2020

You will cover the following concepts in this
chapter:

  Time

  NOW Function

  Dates

  Date Functions

  WORKDAY Functions

  NETWORKDAYS Functions

  Finding the Day of the Week

  SWITCH Function

  Finding Week Number

Lesson 3: Date & Time
Functions



Lesson Notes
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Time Using the Time Functions
Until a cell’s value is formatted as time, Excel displays the time
of day as a decimal number. Excel divides a day down into
decimal increments ranging from 0 (zero) to 0.99988426,
representing 
the times from 0:00:00 (12:00:00 AM) to 23:59:59 (11:59:59
P.M.). Time can be entered into a cell in several ways:
  Manually typing in the time and applying the correct 
formatting.
  Using the [CTRL + ;] keyboard shortcut. This method 

enters the time as a static value, so when it needs to be 
updated it will have to be done manually again.

  Using the NOW() function, inserts the time as a 
dynamic value. When the file is opened or refreshed 
the time value reflects the system time.

  This function does not require any arguments in 
order to return a value.

  By default the cell is formatted as Date and Time, it 
may need to be reformatted as time only, if needed.

  Using the TIME function which is similar to manually 
typing in the time. 

The TIME function syntax has the following arguments:

  Hour: Required. A number from 0 (zero) to 32767 
representing the hour. Any value greater than a 

multiple of 23 will be divided by 24 and the remainder 
will be treated as the hour value. For example, 

TIME(27,0,0) = TIME(3,0,0) = .125 or 3:00 AM.

  Minute: Required. A number from 0 to 32767 
representing the minute. Any value greater than a 

multiple of 59 will be converted to hours and minutes. 
For example, TIME(0,750,0) = TIME(12,30,0) = .520833 
or 12:30 PM.

  Second: Required. A number from 0 to 32767 
representing the second. Any value greater than a 

multiple of 59 will be converted to hours, minutes, and 
seconds. For example, TIME(0,0,2000) = TIME(0,33,22) 

= .023148 or 12:33:20 AM
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To create a 
number format that

includes text that is


typed in a cell, insert an

“at” sign (@) in the text 
section of the number

format code section at

the point where you

want the typed text to 
be displayed in the cell.

If the @ character is not
included in the text

section of the number

format, any text that

you type in the cell is

not displayed; only

numbers are displayed.

Adding and Subtracting Times

 you can enter the following formula;

Adding or subtracting times to get an accumulated time is not an
uncommon necessity, Excel has simple formulas to accomplish

this type of task. 

The result will be 19 hours and 45 minutes. Whether or not 
the cells are formatted for time makes no difference to the

calculation. The Autosum function will work also in this case.

Easy enough when the total time will be less than 24 hours. 
When the total will be greater than 24 hours, the cell needs a

custom number format to return a useful value. 

A custom number formatting of [h]:mm is required since there is 
no built-in format in Excel. Creating the custom number format is 
done by: 

  Opening the Format Cells dialog

  Right-click the cell and choose Format Cells

  Click the [Dialog Launcher] button on the Number 
or Font Groups on the Home Tab
  Choose the Number Tab in the dialog.

  Choose Custom from the bottom of the list of categories 
on the left

As an example, consider two (or more) separate tasks where
each have their own duration. The tasks must be completed in
order 
to move forward on the project and you need to know how much
time the tasks will take to be completed.



Each cell records the time for each task:A1=6:45

A2=5:30

A3=4:30
In cell A4

continued

Add time

=A1+A2+A3

Time,
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In cells that are 
formatted as time 

with AM and PM, 
type a space then “a”
for AM or “p” for PM,
and press [Enter].   In the Type field, typing in [h]:mm.

  Click the [OK] button

Now the desired result of the formula is displayed correctly.

(Notice the empty space at the end of yyyy, and at the end
of mm.)

Another common function is tracking the time spent on a

project when there is a start and end time recorded in the data.
To quickly calculate how much time was spent on the project,

simply subtract the start time from the end time.

When the times being subtracted will be less than 24 hours
use the Time format that includes the AM or PM. This ensures
Excel returns the correct values.



When the time could be greater than 24 hours, the cells
containing the start and end times need to be formatted as
Date and Time using another Custom Format:

continued

Subtract time

=End time - start time

m/d/yyyy h:mm AM/PM. 

Time,
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Years as 00-99yy
Years as 1900-9999yyyy
Months as 1-12m
Months as 01-12mm
Months as Jan-Decmmm
Months as January-Decembermmmm

Months as J-Dmmmmm

Days as 1-31d
Days as 01-31dd
Days as Sun-Satddd
Days as Sunday-Saturdaydddd
Hours as 0-23h
Hours as 00-23hh
Minutes as 0-59m
Minutes as 00-59mm
Seconds as 0-59s
Seconds as 00-59ss
Time as 4 AMh AM/PM

Time as 4:36 PMh:mm AM/PM

Time as 4:36:03 PMh:mm:ss A/P

Time as 4:36:03.75 PMh:mm:ss.00

Elapsed time (hours and minutes) as [h]:mm
1:02

Elapsed time (minutes and seconds) [mm]:ss
as 62:16
Elapsed time (seconds and hun-[ss].00
dredths) as 3735.80

The cell containing the formula will use the same custom
format as discussed earlier; [h]:mm;@ .

Custom Time Formatting Codes

Time,
continued

 To display As Use this code
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Instructions: 
1. Open the Times file.

2. Save the file as My Times.

Format 

Format 

Custom 

Action 1 - Adding and Subtracting Times

Format Cells

Results/ Comments:

3. Select the Weekly Totals sheet.

4. Right-click cell B4 and choose 
Cells from the menu.



5. Click the Number tab.

6. Notice the cell is formatted as time 
without AM/PM.



7. Close the Format Cells dialog box.

8. Select cell G4. 

9. Enter the following formula; 
=SUM(B4:F4) 
press [CTRL + Enter].



10. Right-click the cell and choose 
Cells from the menu.



11. Click the Number tab and choose 

from the list of categories at the left.

12. In the Type field enter the following: 
[h]:mm 
click the [OK] button.



13. Use autofill to fill in cell G5:G8.

14. Select cell B9.

The  dialog opens.

The Format Cells dialog shows what

formatting is applied to the active cell.

The list of existing custom formats are

displayed along with the Type field,

where you can create your own custom

number formats.

Adding the brackets around the hour

section of the format allows Excel to

display more than 24 hours.

Each person’s total is calculated.

Now to calculate the daily totals.

You will calculate the total hours this
person worked throughout the week.

This is a simple addition formula, but the
value of 4:00 being returned is not
usable because any value above 24 is
not shown.



The Format Cells dialog opens.

You will look at the formatting applied to
the cells containing the times.
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Instructions: 

=SUM(B4:B8) 
[CTRL + Enter]

E9.



[Autosum] 
Editing GroupHome Tab

.

Format 

Custom 

Action 1 - Adding and Subtracting Times, continued

[Ctrl +S].

Results/ Comments:

26. Select

cell 27. Click

the 
28. Save the file

15. Enter the following formula; 

press .

16. Repeat steps 9 through 11.

button in the 
on the .

17. Use autofill to populate cells

C9:G9. 18. Save the file.

19. Make the Daily Totals sheet

active. 20. Select cell E4.

21. Enter the following formula 
=D4-C4 
press [CTRL + Enter].



22. Right-click the cell and choose 
Cells from the menu.
23. Click the Number tab and choose 

from the list of categories at the left.
24. In the Type field enter the following 
[h]:mm 
click the [OK] button.

25. Use autofill to fill in cells E5:E9.

The total hours worked are added up.

The formula is a simple addition again.

[CTRL + S].

Click the sheet tab titled Daily Totals.

You will calculate the number of hours
worked by this team member, based on
start and end times.

This subtracts the start time from the
end time. The result should be 3:45 AM.
Next you will clear the AM or PM from
cell.



The Format Cells dialog box opens.

The list of available number formats is

displayed.

The value in the cell will be displayed in

hours and minutes without the AM or PM.

Double-click the Autofill handle to run the
formulas and formatting down to cell E9.

To apply the correct formatting to the cells.
This completes getting the cumulative

hours spent on this project.
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By default the 
NOW function 
is formatted as 

date and time until the
format is changed.

NOW Function Using the NOW Function

Refreshing the NOW Function

 Click on the Formulas Tab.

 Click the [Calculate Now] button in the 
Group.
 All formulas in the workbook are updated.

 Select any cell in the spreadsheet.

 Make the Formula Tab active.

 Click the [Calculate Sheet] button in the 
Group.
 All formulas in the spreadsheet are updated.

- OR-
 Select any cell in the spreadsheet.

The =NOW() is refreshed each time a formula anywhere is

the spreadsheet is added or recalculated. When no new data
is added or changed, the NOW function can be refreshed in

two ways. By calculating the entire workbook or the single

worksheet.

There are times when you need the time in a cell to update

automatically each time the file is opened or refreshed. The 
NOW function does not require any arguments in order to work. 

The syntax of this function is:

=NOW()
Once the formula is added to a cell, apply the appropriate 
formatting.

Calculation 

Calculation 

The entire sheet
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Instructions: 
My Times

Action 2 - Adding a NOW Function

Format Cells 

Results/ Comments:
1. The file should still be open. If 
not, reopen it.



2. Make the Hours Today sheet active.

3. Select cell G3.

4. Enter the following formula: 
=NOW() 
press the [Enter] key.



5. Right-click cell G3 and choose Format 
Cells from the menu.



6. Click the Number tab.

7. Choose Time from the list of categories 
on the left and choose 1:30 PM for the 

options. Click [OK].



8. Select cell C5.

9. Enter the following formula: 
=$G$3-B5 
press the [CTRL + Enter] key 
combination.



10. Right-click cell C5 and choose Format 
Cells from the menu.



11. Choose Time from the list of categories on

the left and click the time without AM/
PM. Click [OK].



12. Use AutoFill to complete the other 
calculations.



13. Click the [Calculate Sheet] button in the 
Calculation Group on the Formula Tab.



14. Save and close the file.

The dialog box opens.

All formulas in the spreadsheet are
updated, including the time.



[Ctrl + S] and [Ctrl + W]

The current time is needed in this cell.

The current date and time are inserted
in the cell.

The list of time formatting options is

displayed. Choose the appropriate format

and apply it.

The total hours worked today will be

calculated here.

Notice the time should have updated to

match the system clock time as the total

hours are returned.

The AM/PM needs to be removed from the
formatting of this cell.



The correct formatting is applied but the
time is not updated.
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Understanding Dates
Excel calculates a date as a number, with number 1 being 
January 1, 1900, and successive dates as the next numbers. 
Unless the cell is formatted as a date, Excel will simply display a

numeric value. As a number, Excel is able to run simple math and
formulas to return relevant information about dates.

There is a wide variety of formulas built into Excel which are

found on the Formula Tab in the ribbon or within the Insert

Function dialog box.

Dates
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Date Functions Using the TODAY Function

Finding the Difference Between Two Dates

This will always return the current date. It is based on the
system’s date (the date on the computer). Formulas which
refer to the cell will be updated every time the file is opened.

As an example: if you need to track the number of days that 
an order takes to be processed. The date the order was made
is subtracted from the current date.

While you can always manually type in a date into a cell or 
use the keyboard shortcut of [CTRL + ;], the date is static and

does not change to reflect the current date. Should you need to

always have a cell display the current date, Excel has the TODAY
function. This formula does not require any arguments in order

to function correctly.

The syntax of the function is:

If you have the dates in cells, use the cell references. When you
plan on using the same type of formula to calculate a range of

cells with autofill, set the End_Date cell reference as an absolute
reference.

This can be a simple math formula that subtracts a start date 
from an end date. It is a math formula because even though 
the cell is displaying a date, it only does so due to the cell’s

formatting. In the background, Excel starts counting days from

January 1, 1900 as 1, each successive day adding another number.
You will notice this numeric value displayed for dates if you turn 
on [Show Formulas]. 

To find the number of days separating two dates, write the

formula as 

=TODAY()

=End_Date-Start_Date

Dates may be 
entered as text 
strings within 
quotation marks (for

example, “2001/1/30”),
as serial numbers (for

example, 36921, which
represents January 30,
2001, if you’re using

the 1900 date system),
or as the results of

other formulas or

functions 
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The DATEDIF 
function is not 
part of Excels’ list 

of functions but it is

commonly used and

understood by the

program.

Note

Date Functions,
continued

Using the DATEDIF Function

  Start_date: the starting date of the period of time. 

  End_date: the ending date of the period of time.

  Unit: The type of information that you want returned:

The table below lists the types of available units.

Unit Returns
“Y”The number of complete years in the period.
“M”The number of complete months in the period.
“D”The number of days in the period.

“MD”The difference between the days in start_date and 
end_date. The months and years of the dates are 
ignored.

“YM”The difference between the months in start_date and 
end_date. The days and years of the dates are ig-
nored

“YD”The difference between the days of start_date and 
end_date. The years of the dates are ignored.

When more specific information is needed, the DATEDIF

formula is ideal since it calculates the number of days, months,

or years between two dates. It must be noted that the DATEDIF
function is not a standard Excel formula.

The syntax of the DATEDIF formula is:

The quotation marks are required when adding the Unit to the formula.

=DATEDIF(start_date,end_date,unit)
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If you need each unit in it’s own cell write each DATEDIF in it’s
own cell instead of combining them in a single cell.

If you need to see the years, months, and days between two
dates then the formula requires a little modification in order to
return the information in the format needed.

To calculate the number of years, months and days between two
dates (more than a year apart) you can use this formula:

  The first DATEDIF will return the number of years 
between to two dates. 

  Adding the &” years, “ will add the text and spaces 
after the number of years. 

  The next & adds the next section of this formula.

  The second DATEDIF, using the “YM” unit returns the

number of months while ignoring the number of years. 

  Adding the &” months, “ will add the text and spaces 
after the number of months. 

  The next & adds the next section of this formula.

  The third DATEDIF, using the “MD” unit returns the 
number of days while ignoring the number of months. 

  Adding the &” days, “ will add the text and spaces 
after the number of months. 
The result between Jan15, 2012 and Feb 27, 2015 would be:

3years,1month,12Days

=DATEDIF(Start_date,End_date,”y”) & “ years,
“ & DATEDIF(Start_date,End_date,”ym”) & “
months, “ & DATEDIF(Start_date,End_
date,”md”) & “ days”

Date Functions,
continued
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Date Functions,
continued

Using the Days Formula

 End_date: required - the last day to be taken into 
account by the formula.

 Start_date: required - the first day to be taken into 
account by the formula.

This is a new formula available in Excel to quickly find the

number of days between a pair of start and end dates. The DAYS
formula returns a numeric value and should not be formatted as

a date. 

The syntax of the DAYS formula is:

=DAYS(End_date,Start_date)
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Instructions: 
Employee_Dates

=DATEDIF(K7,$F$1,”y”)

 & “ Years, “ 

& DATEDIF(K7,$F$1,”ym”)

 & “ months, “ 

& DATEDIF(K7,$F$1,”md”)

& “ days”

Action 3 - Date Calculations

Results/ Comments:
1. Open the 

9. Enter the following formula;

 file.

2. Save the file as My Employee Dates.

3. Select cell F1.

4. Enter the following formula; 
=TODAY() 
press the [Enter] key



5. Select cell J7, and Enter the following 
formula 
=$F$1-I7 

Then, press the [CTRL + Enter] key 
combination.



6. In cell J7, change the formula to: 
=DATEDIF(I7,$F$1,”Y”) 
press the [CTRL +Enter] key 
combination.



7. Use Autofill to complete calculating the 
other employee ages.



8. Select cell L7.

You will be calculating the
employees’ Ages and Years of
Service.

Here you need to know how many years,

month, and days each employee has

worked. 

To return a value in years.

To add the text held within the quotes

To add and return a value in months.

To add the text held within the quotes

To add and return a value in days.

To add the text held within the quotes

This puts today’s date into the cell. It will

always reflect the current date so the data

in the file will be accurate.

This formula works but returns a value in

days. It is possible to use =($F$1-I7)/365 
but that does not help when considering

leap years.

Using the DATEDIF formula will return 
an accurate age. The first argument is the

birth date, the second argument is the

current date, and the last argument defines
the unit of time you want.

Double-click the Autofill handle. 
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Instructions: 
[CTRL + Enter].

Action 3 - Date Calculations, continued

[Ctrl + S].

Results/ Comments:
10. Press the 

11. Use Autofill to complete calculating the 
other employees years of service data.



12. Save the file and leave it open.

Using this key combination applies the

formula to the cell and keeps the cell

actively selected.

Double-click the Autofill handle. 
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WORKDAY
Functions

Using the EDATE Formula

Using the WORKDAY Formula

If you need to add months to a date, the EDATE formula

provides a simple solution. It can return both future and past

dates with equal ease. The cell containing the formula must be
formatted as a date.

The syntax of the EDATE formula is:

 Start_date: required - the starting date to which you 
want to add months to.

 Number_of_Months: required - the number of 
months to add to or subtract from the start date.

  To subtract months, place a minus sign before the 
Number_of_months

Calculating a day in the future can be as simple as adding the

number of days in the future to the current date since the date 
is really a number. If you need to add only working days to a

date to calculate a future date, use the WORKDAY formula. This

formula assumes the work week runs Monday through Friday. It

can also exclude holidays like the NETWORKDAYS formulas.

The syntax of the WORKDAY formula is:

 Date: required - the starting date to which you want to 
add days.

 Number of Days: required - the number of days to 
add to the start date.
 Holidays: optional - can be a range of cells that lists 
holiday dates.

=EDATE(Start_Date,Number_of_months)

=WORKDAY(Start_date,Number_of_days,
[Holidays])
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Number Tab,
3/14/12

[OK].

Instructions: 
My Employee Dates

Action 4 - Adding Working Days to a date

Results/ Comments:

9. Use AutoFill to complete the other 
employee’s probation period 
calculations.



10. Select cell N5.

11. Type in 
Anniversary 
press the [Enter]



12. Select cell N7.

13. Enter the following formula 
=EDATE(K7,6) 
press the [CTRL + Enter] key 
combination.

1. The file should still 
be open. If not, reopen it.



2. Select cell M5.

3. Type in 
Probation period 
press the [Enter] key.

4. Adjust the column width.

5. Select cell M7.

6. Enter the following formula; 
=WORKDAY(K7,90) 
press the [CTRL + Enter] key 
combination.
7. Right-click the cell and choose Format 
Cells from the menu.
8. On the choose Date from the 

left and select formatting. Click 

The column header is added.

Double-click the AutoFill handle.

To add the Header for the column.

The result is correct but needs to
be formatted as a date.



The value in cell M7 is now clear.

This formula will add 90 working days

(excluding weekends) to the hire date in
cell K7. 

Double-click between columns M and N.

This formula adds six months to the hire
date.



Excel: Formulas, Rel. 6.0, 02/17/2020
Lesson 3: Date & Time Functions, Page 74

Instructions: 

Action 4 - Adding Working Days to a date, continued

[Ctrl + S]

Results/ Comments:

[Ctrl + W]. 

14. Use AutoFill to complete the rest of the 
column.



15. Save and close the file.  then 

Double-click the AutoFill handle.
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NETWORKDAYS
Functions

Calculating Working Days

The syntax of the  formula is:

When working long projects it may be necessary to
calculate the number of working days the project will take,
excluding weekends and holidays. Excel has two built-in
formulas 
to run this type of calculation: NETWORKDAYS and 
NETWORKDAYS.INTL.

The syntax of the NETWORKDAYS formula is:

 Start_date: required - represents the start date.

 End_date: required - represents the end date.

 Holidays: is an optional argument, a range of one or 
more dates to exclude from the working calendar, such 

as state and federal holidays and floating holidays. 
The list can be either a range of cells that contains the 

dates or an array constant of the serial numbers that 
represent the dates.

 Start_date and end_date: Required. The dates for 
which the difference is to be calculated. The start_date

can be earlier than, the same as, or later than the end_

date.

 Weekend: Optional. Indicates the days of the week 
that are weekend days and are not included in the 
number of whole working days between start_date 
and end_date. Weekend is a weekend number or string 

that specifies when weekends occur.

 Holidays: is an optional argument, a range of one or 
more dates to exclude from the working calendar, such 

as state and federal holidays and floating holidays. 
The list can be either a range of cells that contains the 

dates or an array constant of the serial numbers that 
represent the dates.

NETWORKDAYS.INTL

=NETWORKDAYS(start_date, end_date,
[holidays])

=NETWORKDAYS.INTL(start_date,
end_date, [weekend],[holidays])
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The weekend argument can be a string of seven characters 
with each character representing a day of the week, beginning
with Monday. 1 represents a non-workday while 0 represents 
a workday. Only the characters 1 and 0 are permitted in the 
string. As an example, 1000001 would result in a weekend that
is Monday and Sunday.



You can also use specific numbers to represent the weekend as 
listed below.
Weekend numberWeekend days
1 or omittedSaturday, Sunday
2Sunday, Monday
3Monday, Tuesday
4Tuesday, Wednesday
5Wednesday, Thursday
6Thursday, Friday
7Friday, Saturday
11Sunday only
12Monday only
13Tuesday only
14Wednesday only
15Thursday only
16Friday only
17Saturday only

NETWORKDAYS
Functions,
continued
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Instructions: 
Project

My Project

Billing

Action 5 - Calculating Working Days and Hours

Results/ Comments:

New Formatting Rul

[Number Format]
Number GroupHome Tab

10. Hold the [CTRL +Shift] keys and press 
the down arrow key once.



11. Click the [Conditional Formatting] 
button drop-down in the Styles Group 

on the Home Tab and choose New Rule.



12. In the Select a Rule Type: field, click Use 
a formula to determine which cells to format 

1. Open the file.

2. Save the file as 

3. On the worksheet, select cell F2.


4. Enter the following formula; 
=NETWORKDAYS(D2,E2,Holidays) 

press the [CTRL + Enter] key 
combination.
5. Format the cell as a number and Autofill 
the rest of the column.
6. Press the [Tab] key to select cell G2.

7. Enter the following formula; 
=NETWORKDAYS(D2,E2,Holidays)*8 

press the [CTRL + Enter] key 
combination.

8. Format the cell as a number and Autofill 
the rest of the column.



9. Press the [Tab] key to select cell H2.

The 

Use the
the 

 drop-down in 
on the .

You will be using a formula to determine
whether or not to apply formatting.

This formula will return the number of

working days between the Start and End

dates, excluding weekends and holidays. 

e dialog box opens.

This will take the value returned by the

NETWORKDAYS formula and multiply 
it by 8. You now have the number of

working hours based on an eight hour
workday.

Use the [Number Format] drop-down in 
the Number Group on the Home Tab.

This column has the number of allocated

hours per project. You will create a

formatting rule to highlight projects where

the hours worked exceed the allotted time.

The rest of the column is selected.
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Instructions: 
Format values where this formula 

is true 
=G2>H2

Format

Fill

Red[OK] 

Action 5 - Calculating Working Days and Hours, continued

Format Cells

Results/ Comments:
13. In the 

field type; 

14. Click the button.

15. Click the tab.

16. Choose a color and click the 
button.



17. Click the [OK] button to apply the 
formatting.



18. Save the file.

The  dialog box opens.

Now when the hours worked exceeds the
allotted time, the cell is filled with red.



[Ctrl + S].

This checks to see if the hours worked
are greater than the allotted time. 
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Finding the Day
of the Week

Using the WEEKDAY Formula

1 or
omitted 2
3
11
12
13
14
15
16
17

Numbers 1 (Sunday) through 7 (Saturday).

Numbers 1 (Monday) through 7 (Sunday).

Numbers 0 (Monday) through 6 (Sunday).

Numbers 1 (Monday) through 7 (Sunday).

Numbers 1 (Tuesday) through 7 (Monday).

Numbers 1 (Wednesday) through 7 (Tuesday).

Numbers 1 (Thursday) through 7 (Wednesday).
Numbers 1 (Friday) through 7 (Thursday).

Numbers 1 (Saturday) through 7 (Friday).

Numbers 1 (Sunday) through 7 (Saturday).

This formula allows you to determine what day of the week any
date is. Use this function when it is important to know on what
day of the week a date falls.



The syntax of the WEEKDAY formula is:

  Serial_number: [required] what day of the week is the 
date you have.

  Return_type: [optional] the argument tells the function 
how to number the days of the week. If you leave this 

argument empty, Sunday will be 1 and Monday will 
be 2 etc. 
Below is the list of available Return_types 

Value Description

=WEEKDAY(serial_number,[return_type]
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Instructions:
My Project

I8.

Sunday
[CTRL + Enter]

Action 6 – Using the WEEKDAY formula

H3.

Results/ Comments:

11. Save the file.

5. Select cell I2 and type: 
then, press the 
combination.



6. Autofill cell I2 down to cell 

 
key 

7. In cell B2, enter the following formula 
=WEEKDAY(A2,1) 

then, press the [Ctrl + Enter] keys.



8. Autofill cell B2 down to cell B17.

1. file should still be open. If 
not, reopen it.



2. Activate the Holidays worksheet.

3. Select cell H2 and type 
1 
then, press [Enter] and type: 2 in cell 



4. Select both cells and use autofill series 
down to cell H8.

9. In cell C2, enter the following formula 
=VLOOKUP(B2,$H$2:$I$8,2) 

then, press the [Ctrl + Enter] keys.



10. Autofill cell C2 down to cell C17.

You now have numbers 1 through 7.

Click the [New Sheet] button.

This will begin the lookup list to use in a
VLOOKUP formula later .

These will be the days that correspond
to the numbers.

The rest of the weekdays should now be
listed beside a number.

The formula will now return a numeric
value representing the day of week the
holiday falls on.

Now each holiday date is shown as a
numeric value of 1 to 7.

This will look for the value in cell A2,
compare it to the table and return the
correct day as a text value.

You now know what day of the week each
holiday falls.



[Ctrl +S].
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SWITCH
Function

First possible match value

Cell with dateFirst Match/Third Match/
Replace pairReplace pair

This negates the need for adding lookup tables and writing 
multiple formulas in cells to get a desired answer.

Subsequent match & replacement pairs

The first argument of the formula (ValueTo Switch) is where the

WEEKDAY function can nested so the day of the week the date 

falls on is returned.

Value To SwitchSecond Match/
Replace pair

In the last exercise the WEEKDAY function returned a numeric

value to represent the day of the week. Once that value was

returned a VLOOKUP was used to compare the returned value

and pull the day from a table. While this worked to show what

day of the week the date occurred on it does require the addition
of the table array needed in the VLOOKUP. Using the SWITCH

function with the WEEKDAY function nested inside would

simplify the process greatly. 

The SWITCH function can be seen like a merged VLOOKUP 
and IFS formula. It changes a cells’ existing value by comparing 
it to up to 126 values. Once a match is found, the match return 
value replaces the original value. Should no matches be found, 
an optional value may be returned.



The syntax of the SWITCH function is ,

Cell whose value is to be replacedFirst possible replacementIf nothing matches use this

=SWITCH(WEEKDAY(Serial_Number),1,”Sunday”,2,”Monday”,3,”Tuesday”,ect)

=SWITCH(ValueToSwitch,MatchValue1,MatchReturnValue1,[2-126 Pair],[NoMatchReturn])

Using the SWITCH Function
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Instructions:
My Project

Action 7 – Using the SWITCH formula

D2

=SWITCH(WEEKDAY(A2),1,”Sunday”, 
2,”Monday”,3,”Tuesday”,4,”Wednesday”, 
5,”Thursday”,6,”Friday”,7,”Saturday”) 
[Ctrl + Enter key] combo
D2 down to cell D17.

[Ctrl + S].

Results/ Comments:

use the 

3. Autofill cell

4. Save the file.

1. file should still be open. If 
not, reopen it.



2. Select cell and enter the following 
formula; 

This formula will return the day of the
week without any other lookups.
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Finding Week
Number

Using the WeekNum Formula

Return_type
1 or omitted
2
11
12
13
14
15
16
17
21

Week begins on
Sunday
Monday

Monday

Tuesday


Wednesday

Thursday

Friday
Saturday

Sunday
Monday

System
1
1
1
1
1
1
1
1
1
2

 Serial_number : Required. A date within the week. 
Dates should be entered by using the DATE function, 

or as results of other formulas or functions. For 
example, use DATE(2008,5,23) for the 23rd day of May, 
2008. Problems can occur if dates are entered as text.

 Return_type: Optional. A number that determines on 
which day the week begins. The default is 1.

This formula will return the week number of a specific date. As 
an example, the week containing January 1 is the first week of
the year, and is numbered week 1 up to a possible week 52.



There are two systems used for this function:

  System 1: The week containing January 1 is the first 
week of the year, and is numbered week 1.
  System 2: The week containing the first Thursday of 
the year is the first week of the year, and is numbered 

as week 1. This system is the methodology specified in 
ISO 8601, which is commonly known as the European 
week numbering system.

The syntax of the WEEKNUM formula is:

 

 

=WEEKNUM(serial_number,[return_type])
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Finding Week
Number,
continued

Using the ISOWEEKNUM Formula
ISO8601: 2000 is becoming mandatory in the European Union

and is becoming more commonly used throughout the rest of the
World.

There may come a time when you need to know what week

number of the year a specific date falls in. Excel has added a new
formula to make this easy to determine, the ISOWEEKNUM

formula.

The syntax of the ISOWEEKNUM formula is:

  Date: Required- any date after January 1 1900 is valid. 
Dates before the January 1 1900 will return a #NUM 
error.

  The date cell must be formatted as a date in order 
for the formula to work.




The Standard issued in 1986, prescribes amongst other things,

  Dates must be formatted as either:

  A non-separated form of yyyymmdd (20160130 for 
30-Jan-2016)
  A separated form of yyyy-mm-dd (2016-01-30 for 
30-Jan-2016)
  Week numbering, must use one of the two following 
systems:
  Week 1 begins on the Monday where 4th January 
falls.

  Week 1 begins on the Monday that contains the first 
Thursday of the calendar year.
So it will be up to your requirements as to which of these 
formulas to use.

=ISOWEEKNUM(Date)
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Instructions: 
MyProject

Action 8 - Find the Week number

Results/ Comments:

5. Save and close the file

1. The file should still be open. 
If not, reopen it.



2. Select cell E2.

3. Enter the following formula; 
=WEEKNUM(A2) 
press the [Ctrl + Enter] keys.

4. Autofill cell E2 down to cell E17. You now know the week number each
holiday falls in.



[Ctrl + S] and [Ctrl + W].

This formula will return the week number
of the year you were born in.



Tips and Notes



Lesson Overview

Excel:
Formulas 6.0,
02/17/2020

You will cover the following concepts in this
chapter:

  Formula Auditing

  Tracing Formulas

  Errors

  Error Checking

  Evaluating Formulas

  Watch Window

  Calculations

Lesson 4: Formula
Auditing



Lesson Notes
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You may frequently be given spreadsheets that were created by
other users or created in previous versions of Excel in which the

formulas no longer function or show error messages. In this

lesson, you will learn to use the tools Excel has to help you audit
and correct these formula errors and issues.

The Formula Auditing Group on the Formulas Tab has tools
to 
facilitate management of your formulas. A variety of tools allow
you to:

  Trace Precedents and Dependents: displays blue lines 
showing where formulas draw their data. 

  Precedents show where the selected cell is drawing 
data from.
  Dependants show connections to cells that are 
referencing the selected cell.

  Remove Arrows: clears the lines from the spreadsheet.

  Show Formulas: displays the formulas in their cells as 
opposed to the formula results.

  Error Checking: examines the spreadsheet for formula 
errors in a similar manner as using spell check.
  Evaluate Formulas: opens a window where you can 
move through the formula in a step by step process.
  Watch Window: opens a window that can 
dynamically display results of multiple formula 
changes as data is modified.

The Formula Auditing Group

Formula
Auditing
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Tracing Precedents 

If there are any cells referencing content from other worksheets
or workbooks, a black dotted line and worksheet icon will

appear. To follow the precedents, double-click the dotted line

(not the icon) to open the Go To dialog box.

Any 3D references will be listed in the Go To dialog box. Select

the one you want to follow and click the [OK] button to move to

the sheet or file. If the file is not currently open, it will be opened.

The [Trace Precedents] button will indicate which cells the
active cell is drawing data from. A Precedent is a cell that
contributes 
to the result. 
When the button is clicked a blue line appears. It traces
backward to the cells that influence the current cell’s formula.
Dots on the line show where the source cells are.

Clicking the button again will show the precedents of any

preceding cells that contain formula references. Continue clicking
the [Trace Precedents] button to continue examining formula

connections.

Tracing Formulas
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Removing Arrows

Tracing Dependents

 Remove Arrows: this will remove all the arrows at 
once.

 Remove Precedent Arrows: removes the last level of 
precedent arrows applied.
 Remove Dependent Arrows: removes the last level of 
dependent arrows applied.

Since you can show both types of arrows at the same time,
the [Remove Arrows] button will remove any and all
Precedent or Dependent arrows with a single click. The drop-
down for the [Remove Arrows] button will offer three
choices:

This tool is used to see what other formulas are drawing data

from the active cell. The Dependent cell does have to contain 
a formula. It can be a static value. The arrows will now point 
to cells that the active cell contributes to. Just like the [Trace

Precedent] button, if you continue to click the button it will show
the next level of cells that the active cell contributes to.

 

 

 

Tracing

Formulas,
continued
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F13.

Instructions: 
Tracing.xlsx

MY Tracing

QTR 1

Action 1- Tracing Formulas

[Remove Arrows] 
Formula Auditing Group

Formulas Tab.

[Trace Precedents] 
Formula Auditing Group

Formulas Tab.

[Trace Precedents] 

[Remove Arrows] 
Formula Auditing Group
Formulas Tab.

B6.



[Trace Dependents] 
Formula Auditing Group

Formulas Tab.

[Trace Dependents] 

Results/ Comments:

5. Click the 
the 

6. Click the

again.

7. Click the 
the 

10. Click the

again.

11. Click the 
the 

1. Open the 

4. Select cell 

8. Select cell 

9. Click the

in the 

2. Save the file as

3. Make the 

 file.

 sheet active.

button 

button 

button in

on the 

button in

on the 

button in
on the 

button 
on the 

Click the QTR 1 sheet tab below the
spreadsheet.



This cell is the result of a summing
formula.

A blue line indicates what cells are
referred to by the formula in cell
F13.

The file is stored in the class data files

folder, the instructor will point out where

to find the folder.

More lines appear, pointing to the next

cells that are dependent on the active cell

in their formulas. 
A black dotted line pointing to a

spreadsheet icon also appears, indicating

that formulas in other locations depend on
the cell in their calculations.

The arrows are removed from the

spreadsheet.

A new set of lines indicate the cells being
referred to by the first set of cells that are
being calculated in cell F13.

The arrows are removed from the
spreadsheet.

This cell contains a value that another 
cells’ formula is referring to.

Blue lines point to the cells that include
the active cell in their formulas.
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Instructions: 

12. Make the Summary 

13. Select cell F13.

 [OK] 

Action 1- Tracing Formulas, continued

Summary

[Remove Arrows] drop-down 
Remove Precedents 

Results/ Comments:

20. Save and close the file.

sheet active.

16. Select the reference and click the
button.



17. Make the sheet active.

18. Click the 
button and choose 
Arrows.



19. Click the [Remove Arrows] button.

14. Click the [Trace Precedents] button three 
times.



15. Double-click any of the dotted lines..

The arrows are removed from the
spreadsheet.



[CTRL + S] and [CTRL + W].

Click the tab below the spreadsheet.

One level of Precedent lines is
removed from the spreadsheet.

Click the tab below the spreadsheet.

This cell contains a formula referring to
other cells in the spreadsheet.

Each time the button is clicked the
formula is traced back another level.



The Go to dialog box opens, showing the
reference or related references.

The reference location is now active.
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Errors Errors

Error Messages

Errors can be marked and corrected in two ways: 
  Using the [Error Checking] button (like a spelling 
checker) checks for errors on the entire spreadsheet

  Using the Error Checking Options immediately when 
they occur on the worksheet as you work. 
When an error occurs, a green triangle appears in the upper-left 
corner of the cell.

Some errors cannot return a result and will display an error value

in the cell. The error messages are simple ways Excel explains

problems in formulas.

occurs when Excel does not recognize text 

#NAME?in a formula, if using a name in a formula 
and the name is misspelled or does not 
exist

occurs when a formula has the wrong type 

#VALUE!of argument, if the formula is expecting 
numeric values but a cell contains text or 
dates




#DIV/0!occurs when a formula tries to divide a 
number by 0 or an empty cell
occurs when a formula refers to a cell that 

#REF!is not valid, if the formula refers to a cell in 
a deleted row or column

occurs when you specify a intersecting 

#NULL!range which in fact does NOT intersect,
the value in a cell may be a negative value, 
percent, or currency value

occurs when the wrong type of argument 

#N/Aor operand is used in the formula,
most common in relation to lookup 
formulas
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Error Checking Error Checking Options

When the icon is clicked a drop-down menu displays offering

suggestions on how to resolve the potential error. This could be
a potential error because you may not need to refer to the same
relative range in this instance. In which case Ignore Error would

be the best option to avoid having the icon appear when the cell
is selected.

Other errors still return values but show error warnings, such as

being inconsistent with adjacent formulas. The error may advise
you to examine the formula. When the cell with the error is

active, a small warning icon is displayed to the left of the cell.

: the basis error (it can change 
depending on the formula) that has determined

: will copy the formula from 
the cell above to remove the perceived error
: opens the dialog box to the 
specific error type help page
: leaves the formula as is without 
continuing to display the 
smart tag

 displays the formula in the 
formula bar
: opens the dialog 
box, where you can select the rules governing error 
checking

 Inconsistent Formula
Excel

 Copy Formula from Above

 Help on This ErrorHelp

 Ignore ErrorExcel
Error Checking Options


 Edit in Formula Bar:

 Error Checking OptionsOptions

 

 

 

 

 

 

When multiple 
cells containing 

errors are selected, 
the Error Checking 
Options smart tag is

not displayed.
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Error Checking

While still in the process of checking for error in the Error

Checking dialog, clicking the [Options] button will open the

Options dialog where there are more controls relating to how
Excel will treat errors.

As one formula is corrected, click the [Next] button to advance
to the next found error. When all errors have been checked

displays a message to that effect. 

The tool works in a similar fashion as running a spell check in
other programs. It will inspect the entire spreadsheet looking 
for errors which may not have been noticed while creating the

spreadsheet.

If the [Error Checking] button is clicked, the Error Checking 
dialog opens. You could go through the spreadsheet checking

each error at one time. These are similar options to those found in 
the Error Checking Options Smart Tag menu.

Excel 

Excel 

Error Checking,
continued



Excel: Formulas, Rel. 6.0, 02/17/2020 

Lesson 4: Formula Auditing

Page 97

Formula Options

When in the options you are able to turn error checking on or
off, and even change the color of the error warning triangle 
from withing the Error Checking group of controls. In the Error
Checking Rules group of commands you are able to determine
what errors will be ignored or tracked.
  Cells containing formulas that result in an error: 

Turning this off will stop the display of error messages
  Inconsistent calculated column formula in tables: 
Turning this off will stop displaying Error Checking 
Options smart tags for any formula that could be 
perceived as being inconsistent inside an Excel table 
only.

Turning off error checking is done through the program options.

When you click the [Options] button in the Error Checking dialog

you can edit the program options directly. A more direct method

to access the program options is to click File Tab, then choose

Options, and then the Formulas category.

Error Checking,
continued

Try using the 
keyboard to 
navigate the 

program to access

the Options by

sequentially tapping

the ALT, F, T keys.



Page 98 

Lesson 4: Formula Auditing 

Excel: Formulas, Rel. 6.0, 02/17/2020

Exceptions within a calculated column in a table are:
  If you type data other than a formula in a calculated 

column cell.
  If you type a formula in a calculated column cell 
and then click [Undo] button on the Quick Access 
Toolbar.

  If you type in a new formula within a calculated 
column cell containing one or more exceptions.

  If you copy data into the calculated column using a 
different formula.
  If you move or delete a cell on another worksheet 
area that is being referenced by a row within a 
calculated column.

  Cells containing years represented as 2 digits: Turning 
off this rule will stop Excel from checking for unclear 
dates, when a cell contains dates which could be 
misinterpreted as the wrong century.
  Numbers formatted as text or preceded by an 
apostrophe: Turning this rule off will stop Excel 
warning you that a numeric value could be formatted 
as text. When this occurs Excel will display the Error 
Checking Options smart tag triangle in the upper left 
corner of the cell. When there are numbers stored as 
text, it will cause unexpected sorting behaviors and 
prevent the values from being calculated.

  Formulas inconsistent with other formulas in the 
region: Turning this rule off will stop Excel from 
warning you when a formula does not match the 
pattern of other formulas near by. In many cases, 

formulas that are adjacent to other formulas differ only 
in the references used.

Error Checking,
continued

If the copied data 
contains a formula, 

this formula 
overwrites the data in

the calculated column.
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Instructions: 
1. Open the Errors file.

2. Save the file as My Errors.

3. Select cells E6:E17.

Action 2- Error Checking

[Error Checking]
Formula Auditing Group

Formula Tab.

Results/ Comments:

[ALT + Enter] 

13. Click the 
the 

 button in

on the 

4. Click the [Autosum] button drop-down 
in the Function Library Group on the 

Formulas Tab and choose Average.



5. Select column E.

6. Right-click the column and choose Insert 
from the menu.
7. Select cell E5 and type in: 
Photo Corrections 
press the [Enter] key.

8. In cell E6, type: 85 
then, press the [Enter] key.
9. In cell E7, type: 78 
then, press the [Enter] key.
10. Select cells E6:E7.

11. Use autofill to fill in the remaining 
grades. Click the Autofill Options smart 

tag and choose Copy Cells.

12. Select cell F8 and click the Error Checking 
Options smart tag. Choose Update formula 

to include cells.

The project header is added. If you
want to add a soft return, use the 
key combination.

We will add a formula to average the

grades here.

The formula is added to all the cells.
You can also find the [Autosum] button in 
the Editing Group on the Home Tab.

Click the column header E.

A new column is added after column D.

The original formula reads as: 
=AVERAGE(B8:D8).
After updating the formula, now reads as: 
=AVERAGE(B8:E8).

The Error Checking dialog box opens, this

acts like a spell check dialog box. You can

check every error that potentially exists in

the spreadsheet.

Choosing to copy the cells will fill the cells
with the number pair.
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Action 2- Error Checking, continued

Instructions: 
[Update formula to include 

cells] 


[OK]

File TabOptions
Formulas
Error Checking

Results/ Comments:

16. Click [OK].

17. Save and close the file.

14. Click the 
button, repeat this to correct all the 

errors. When all have been updated, click 
the button to close the dialog box.



15. Click the and choose . 
Choose the category and 
examine the options.

Each error is displayed and you are given
options on how to correct them. When all
errors have been checked a dialog box
lets you know the checking is completed.



The Formula Error options can also be
accessed from within the Error Checking
dialog box by clicking the [Options]
button.

To close the options.

[CTRL + S] and [CTRL + W].
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Using the Evaluate Formula Tool

 Clicking the [Evaluate] button begins replacing cell 
addresses with their values and moving through the 
formula, step by step. Keep clicking the button until 
the entire formula has been shown and you see the end 

result.

 When the result is displayed in the Evaluation: field, 
you can click the [Restart] button to go back through 

the formula again if necessary.

The [Evaluate Formula] button will open an Evaluate Formula 
dialog box, allowing you to see the formula and go through it 
step by step. Showing each step of the formula’s calculation, 
so you can see the logic behind the formula. This tool is also

extremely useful in helping to understand where problems exist

within a formula.

  Select the cell containing the formula you would like to 
evaluate.
  Click the [Evaluate Formula] button in the Formula 
Auditing Group of the Formulas Tab.

  The Evaluate Formula dialog box will open. In the 
Evaluation: field, the formula from the selected cell is 
displayed.

 

 

Evaluating
Formulas
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 Continue to click the [Step In] button to see the string 
of cells needed for your formula to function. Each 

connection to cells that use formulas is displayed in a 
new level field of the Evaluation: field.

 Click the [Step Out] button to move back one level at 
a time until you are back to the original formula being 

evaluated.

 Clicking the [Step In] button will evaluate each section 
of the formula that is underlined. If a cell address is 

underlined and it is in fact the end result of a formula,

the formula in that cell address is displayed in another 

new window below the main Evaluation: field.

 

 

 

Evaluating
Formulas,
continued
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[Step in]

 [Step In] 

[Step out] 

[Evaluate] 

Instructions: 
1. Open the Evaluation

2. Save as My Evaluation

3. Select cell H2.

Action 3- Evaluating Formulas

[Evaluate Formula] 
Formula Auditing Group 
Formulas Tab

Evaluate 

Results/ Comments:

7. Click the

4. Click the 
the 

6. Click the 

8. Click the 

9. Click the 

 file.

 button.

button.

.



5. Examine the formula in the 
Formula dialog box.

button again.

buttons twice.

button in
on the 

This cell contains a formula to be

evaluated.

The Evaluate Formula dialog box opens.

The formula in cell H2 is displayed in the
Evaluation field. The underlined portion
of the formula is the active part of the
formula being evaluated. As the formula
is evaluated step by step, the underline
changes to show what part of the formula
is active .

Since the value is cell G2 results from a
formula, the formula used to determine
the value in cell G2 is displayed below.
Notice, it is indented to show it is a
secondary formula to the formula being
evaluated.

Each time the [Step in] button is clicked,
the formula is traced back to the original
data the formula is drawing on. Once 
all levels of the formulas have been
displayed, the value returned by the
formula is displayed.

Click this button to step back through the
interconnected formula until all indented
fields are removed. 



The first cell reference is replaced by the
value in the cell. 
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Instructions: 

Action 3- Evaluating Formulas, continued

[CTRL + S] 

Results/ Comments:
[Evaluate] 

 [CTRL + W].

10. Continue clicking the [Evaluate] button
until the formula results are displayed.

11. Click the [Restart] button to begin going 
through the formula again, or click the 

[Close] button to exit the dialog box.



12. Save and close the file. and

Each click of the button reveals the next
step in the formula until all steps are
shown and the result of the completed
formula is displayed. The [Step in] 
button is only active when the cell being
examined has a formula.

Choose whether to re-evaluate the
formula or close the dialog box.
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Watch Window Using the Watch Window

To Add a Cell to the Watch Window
 

 dialog box, click the 

 button in the 
to open the 

 Click on the cell in the worksheet or workbook that 
you would like to watch.

 Click the [Add] button.

The Watch Window allows you to monitor the results of a cell

when another cell is changed. The Watched cell can be on the

same sheet, a different sheet, or even in a different file.

In the Watch Window, you can add watches to the cells that you
want to track changes being made somewhere else in the file

without having to scroll from one place to another. Once a 
Watch has been added to the window, it shows the workbook,

worksheet, name of the cell (if the cell has a name), cell address,
the cell values, and formulas. Add as many Watches as needed, 
so you are able to easily keep track of changes from multiple

locations in one window. The Watch Window can be docked to the
top, bottom, or either side of the interface by dragging it to the

desired position. It can also be left as a floating window, and will

remain open until it is closed using the [Close] button in the top

right corner.

 In the Watch Window
Watch...] button.

 Click the [Watch Window]
Auditing Group of the Formulas Tab

Window dialog box.

[Add 

Formula 
Watch 

 

 

 

If you select a 
range of cells, each 

of the selected cells 
will be added as it’s

own watch.
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Watch Window,
continued

  Select the Watch you would like to delete in the Watch 
Window dialog box.

  Click the [Delete Watch] button.

When you close a file, the associated cell in the Watch Window

dialog box will disappear. However, when the file is re-opened,

the cell will reappear in the Watch Window.

To close the Watch Window dialog click the [X] button.

As long as the file and the Watch Window dialog box remain
open, you will see the values update when the data is altered.

To Delete a Cell from the Watch Window
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H67.

Instructions: 
WatchWindow

My WatchWindow

A67 Totals

G67

=SUM(G2:G65) 
then, [CTRL + Enter]

H67

Action 4 - Using the Watch Window

H67
Watch Window

[CTRL + S].

Results/ Comments:

12. Select cell G5 and type: 25
then, press the [Enter] key.

10. Add another watch for cell 

13. Save the file and leave it open.

11. Dock the Watch Window above the 
Formula bar.

7. Click the [Watch Window] button in 
the Formula Auditing Group on the 
Formulas Tab.



8. Click the [Add Watch...] button.

9. Highlight the field and select cell G67 
and click the [Add] button.

1. Open the file.

2. Save as 

3. Select cell and type: 

4. Select cell and enter the following 
formula: 

press the .

5. Use autofill to populate cell with a 
relative copy of the formula.
6. Select cell A1.

A total of all sales is added.

A new header is added.

A total of units sold is added.

[CTRL + Home] key combination takes

you back to cell A1 from anywhere in the

spreadsheet.

The Watch Window opens.

The Add Watch dialog box opens.

The cell is added to the Watch Window. Any
relevant information regarding the cell is

displayed for tracking proposes.

Repeat the Add Watch process for cell 
H67.

Drag the window by the title-bar up 
toward the formula bar. It will snap into

position.

Editing a cell’s contents will impact the

results of the formulas in cells G67 and 
. These changes are shown in the 
.
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Clicking the  button offers three choices:

 Click the [Calculation Options] button in the 
Calculations Group on the Formulas Tab and choose 
Manual. 

Change data in the cells that the formula needs to 
calculate.

 Automatic: This is the default choice. The formula is 
recalculated any time data is updated.

 Automatic Except for Data Tables: If there are Data 
Tables being used in the file, they are not recalculated 
as data is updated.

 Manual: The cell will not recalculate until you decide 
to run the calculation.

By default, Excel is set to update formula results as changes are

made. There are times when having Excel automatically update

the formula as you enter new or change data can be prove

confusing. You may want the calculation to update once all your

changes have been completed, instead of being done in real time.
You can change the default calculation setting by using the 
[Calculation Options] button in the Calculation Group on the
Formulas Tab.

 [Calculation Options]

 

 

 

 

Changing the Calculation Option
 

Calculations
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  Click the [Calculate Now] button in the Calculation 
Group on the Formulas Tab to recalculate the formulas 

on all open sheets and all open workbooks.

-OR-
  Click the [Calculate Sheet] button in the Calculation 
Group on the Formulas Tab to recalculate all the 
formulas on the active sheet only, not on other open 
sheets or open workbooks.

Both the Manual option and the [Calculate Now] button operate 
independently of the cells that are selected. Both commands 
apply to all cells, all sheets, and all files. 

Both commands affect the entire Excel program and neither 
command is limited to any specific cell, cells, sheet, sheets, 
workbook, or workbooks.

Changing the Manual option on the ribbon is the same as 
changing the Manual option by going to the File Tab, selecting 
Options, then clicking the Formulas Tab on the left, and 
choosing Workbook Calculation under the Calculation options 
section.

Calculations,
continued
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Instructions: 
WatchWindow

Action 5 - Calculations

[Calculation Options]
Manual



G65 50
[Enter]

Results/ Comments:

G67:H6

7

G67:H6

7
G67:H67

[CTRL + W]

9. Recalculate the sheet.

10. Save and close the

file.

5. Click the 
and choose .



6. Select cell and type: 
then, press the key.

3. Select cell G65 and type: 25 
then, press the [Enter] key.



4. Select cells G67:H67.

1. The file should still be 
open. If not, reopen it.



2. Close the Watch Window.

 button 

7. Click the [Calculate Sheet] button.

8. Try changing the value in cell G65 again.

The values in cells 

The values in cells
updated.



The values in cells 

[CTRL + S] and 

 are

updated. 

 are not 
 are

updated. .

Click the [X] button at the upper right
corner of the window.

The values in cells G67:H67 change to
reflect the changes to the data.

These cells currently are set to calculate
automatically.

This turns off the automatic calculation
for these cells.



Notice the values in cells G67:H67 do not
update to reflect the changes to the data.



MICROSOFT OFFICE
EXCEL ASSOCIATE EXAM
MO-200

Navigate within workbooks

Import data into workbooks

Customize options and views

Configure content for collaboration

Format worksheets and workbooks

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT

Import data from .txt file

Import data from .csv files

Modify page setup
Adjust row height and column width
Customize headers and footers

Customize the Quick Access toolbar

Display and modify workbook content in 
different views
Freeze worksheet rows and columns
Change window views
Modify basic workbook properties
Display formulas

Set a print area
Save workbooks in alternative file
formats Configure print settings
Inspect workbooks for issues

Search for data within a workbook
Navigate to named cells, ranges, or workbook 
elements
Insert and remove hyperlinks

DA
DA

L-

1

L-

2

L-

3
L-
1
L-
1
L-
1L-

1

L-

2

L-

2
L-
2
L-

2
L-
1

L-
1
L-
1
L-
1
L-
1
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Modify tables

Format cells and ranges

Summarize data visually

Create and format tables

Manipulate data in worksheets

Define and reference named ranges

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT

Define a named
range Name a table

Create Excel tables from cell
ranges Apply table styles
 Convert tables to cell ranges

 Insert Sparklines
Apply built-in conditional formatting
Remove conditional formatting

Add or remove table rows and
columns Configure table style options
Insert and configure total rows

Paste data by using special paste options
Fill cells by using Auto Fill
 Insert and delete multiple columns or
rows Insert and delete cells

Merge and unmerge cells
Modify cell alignment, orientation, and 
indentation
Format cells by using Format Painter
Wrap text within cells
Apply number formats
Apply cell formats from the Format Cells dialog 
box
Apply cell styles
Clear cell formatting

L-
1
L-
1
L-
1
L-
1
L-

1

L-

1

L-

1
L-
1
L-

1

L-

1

L-

1
L-
1

L-
2
L-
2
L-
2L-
2
L-
2
L-
2L-
2
L-
2
L-
2

L-2 / FM

DA
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Create charts

Modify charts

Insert references

Format and modify text

Filter and sort table data

Calculate and transform datas

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT

Create charts

Create chart sheets

Filter records
Sort data by multiple columns

Add data series to charts
Switch between rows and columns in source 
data
Add and modify chart elements

Insert relative, absolute, and mixed
references Reference named ranges and
named tables in 
formulas

Format text by using RIGHT(), LEFT(), and

MID() functions
Format text by using UPPER(), LOWER(), and 
LEN() functions
Format text by using the CONCAT() and 
TEXTJOIN() functions

Perform calculations by using the AVERAGE(),
MAX(), MIN(), and SUM() functions
Count cells by using the COUNT(), COUNTA(), 
and COUNTBLANK() functions
Perform conditional operations by using the 
IF() function

DA

DA

DA

L-
2
L-
2
L-

1

L-

2

L-1

DA

FM

L-2 / CH
L-2 / CH

L-2 / CH

L-2 / CH

L-2 / CH
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CODES
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Manage workbooks

Format and validate data

Fill cells based on existing data

Use and configure language options

Prepare workbooks for collaboration

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT

Copy macros between workbooks

Reference data in other workbooks
Enable macros in a workbook

Manage workbook versions

Restrict editing
Protect worksheets and cell ranges
Protect workbook structure
Configure formula calculation options
Manage comments

Fill cells by using Flash Fill
Fill cells by using advanced Fill Series 
options

Configure editing and display languages
Use language-specific features

Create custom number formats
Configure data validation
Group and ungroup data
Calculate data by inserting subtotals and 
totals
Remove duplicate records

L-
3
L-
3
L-
3
L-
2
L-
2
L-
2
L-
2
FM
L-
2
L-
1
L-
1
L-

1

L-

2
L-1

L-3 / FM

L-3

L-3

DA
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Perform data analysis

Look up data by using functions

Use advanced date and time functions

Perform logical operations in formulas

Apply advanced conditional formatting and filtering

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT

Look up data by using the VLOOKUP(),

HLOOKUP(), MATCH(), and INDEX()
functions

Perform logical operations by using

nested functions including the IF(), IFS(),

SWITCH(),
SUMIF(), AVERAGEIF(), COUNTIF(), 
SUMIFS(), AVERAGEIFS(), COUNTIFS(), 
MAXIFS(),
MINIFS(), AND(), OR(), and NOT()

functions

Reference date and time by using the

NOW() and TODAY() functions
Calculate dates by using the WEEKDAY() 
and WORKDAY() functions

Create custom conditional formatting rules

Create conditional formatting rules that use 
formulas
Manage conditional formatting rules

Summarize data from multiple ranges by

using the Consolidate feature
Perform what-if analysis by using Goal Seek 
and Scenario Manager
Forecast data by using the AND(), IF(), and 
NPER() functions
Calculate financial data by using the PMT() 
function

FM

FM

FM

FM

FM

FM

L-

2

L-

2

L-

2

L-

3

L-

3

FM

FM
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Troubleshoot formulas

Create and modify PivotTables

Create and modify PivotCharts

Create and modify simple macros

Create and modify advanced charts

Excel Level 1 L-1 Excel
Level 2 L-2 Excel Level 3
L-3 Excel Formulas FM
Excel Data Analysis DA
Excel Charts CH Excel
PivotTables PT Excel
Data Analysis with
PowerPivot PPT Record simple

macros Name simple
macros Edit simple
macros

Create PivotTables
Modify field selections and
options Create slicers
Group PivotTable data
Add calculated fields
Format data

Create PivotCharts
Manipulate options in existing PivotCharts
Apply styles to PivotCharts
Drill down into PivotChart details

Trace precedence and dependence
Monitor cells and formulas by using the 
Watch Window
Validate formulas by using error checking 
rules
Evaluate formulas

Create and modify dual axis charts
Create and modify charts including Box & 
Whisker, Combo, Funnel, Histogram, Map, 
Sunburst, and Waterfall charts

FM

FM

FM

FM

CH

CH

PT
PT
PT
PT
PT
PT

PT
PT
PT
PPT

L-
3
L-
3
L-
3

TCW BOOK

CODES


